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This guide contains additional information you may
need for using the Visi On Graph' program to create
graphs for your own specific needs, update them, and
transfer the information in them to the other Visi On'
programs.

The User's Guide is designed to be used after you have
learned the basics of the program through the Visi On
Graph QuickStart Course'" . Figure 1 illustrates the
relationships among the learning tools that are available
to you .

The Visi On Tutorial is an introduction to the Visi On
environment . It teaches you, by having you actually use
the computer, how to use the Visi On system with any
of the Visi On programs . Anyone using the Visi On
system should complete this Tutorial before attempting
to use any of the Visi On programs .

The Visi On User's Guide provides a complete reference
to the Visi On system . In addition to supplying a
complete overview of the system, each chapter
discusses one basic set of functions that you use within
the system .

The Visi On Graph QuickStart Course teaches you the
basic operations of the Visi On Graph program . Its
hands-on exercises prepare you for entering data and
creating your own graphs . Before you use the Visi On
Graph program, you should take this QuickStart
Course.

After the QuickStart TM Course . . .
In this guide, instructions about the types of tasks you
can perform with the Visi On Graph program are
grouped together in chapters . Each chapter covers one
general task within the program, such as entering
series information or labeling a graph . All tasks related
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Figure 1 . The Visi On Learning Tools

to carrying out that operation (such as entering,
moving, and removing labels) are described in detail
within that chapter.

After you read Chapter 1, which discusses the
program's concepts and terminology, you can go
directly to any chapter containing specific information
you need to complete a task .



Getting Help
The Visi On Help facility is available to you at any time .
Simply selecting "HELP" from the Visi On menu line at
the bottom of your screen will provide you with
additional instructions that can help you with the task
you are doing. You simply point to and select the item
you need help with on the screen, and a special Help
window opens that contains instructions for that
particular item .

Organization of this Guide

Using this Guide xiii

For example, if you feel comfortable with series editing
and plotting graphs after completing the QuickStart
Course, you can either begin creating simple graphs, or
turn to Chapter 5, "Enhancing Your Graphs ;" to get
more information about changing a graph's appearance .
If, however, you need details on printing, go directly to
Chapter 6, where you'll find examples of the different
types of printed displays you can create .

In either case, and at any time, you can go directly to
the type of instruction you need .

This guide consists of five major sections :

I OVERVIEW contains the terminology and basic
concepts used in the program, as well as summaries
of program operations, such as starting and quitting
the program .

•

	

BASIC OPERATIONS consists of eight chapters that
contain step-by-step procedures for performing all
the tasks related to each program operation . You can
select which section of each chapter you need to
read or review, depending on the task you want to
perform.

•

	

EXAMPLES guide you through several applications
you may use with the Visi On Graph program .
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•

	

MESSAGES lists all the error messages the program
can give you . Each error message is explained,
describing what could have caused the error and
giving details what you can do to correct it .

•

	

GLOSSARY/INDEX provides both a glossary that
defines all the terms used in the Visi On Graph
program and an index to the guide. It can be
effectively used for learning or reviewing special
terms that might be unfamiliar to you . The index
lists and cross references all major topics and terms
used in this guide, providing a quick reference for
locating any program function or command .

CHAPTER 1: OVERVIEW introduces the Visi On Graph
program and its basic concepts and features .

CHAPTER 2: SAVING, GETTING, AND
ORGANIZING SERIES AND GRAPHS provides the
information you need to know about storing (saving)
and retrieving (loading) files . This chapter also
discusses saving and loading a complete graph and
clearing information from the computer's memory .

CHAPTER 3: CREATING SERIES outlines all the steps
needed to enter the information you want to turn into a
graph . The Visi On Graph program requires you to
enter all your data as series values before it can draw
your graphs .

CHAPTER 4: TURNING SERIES INTO GRAPHS
contains all of the steps needed to create bar, line, pie,
X-Y, area, and high-low-close graphs .

CHAPTER 5: ENHANCING YOUR GRAPHS contains
information applicable to all types of graphs . It
discusses labeling and removing labels from an existing
graph, overlaying graphs, and changing a graph's range
and scale and changing graph display options .

CHAPTER 6: PRINTING discusses how you print your
graphs and series information .

CHAPTER 7: TRANSFERRING INFORMATION
describes what types of information can be transferred
into and out of the Visi On Graph program from other
Visi On programs, and how to specify the areas to be
transferred .
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CHAPTER 8: EXAMPLES provides step-by-step
examples for creating samples of each type of graph .
This chapter also introduces you to alternate ways of
displaying your information .

CHAPTER 9: MESSAGES lists the error messages that
might display when you are using the Visi On Graph
program . Each message description contains an
explanation of what caused the error and what you can
do to correct the problem .

APPENDIX A: CONVERTING VISITREND/PLOT®
SERIES FOR USE WITH THE VISI ON GRAPH
PROGRAM describes the procedures for converting
VisiTrend/Plot so you can use them with the Visi On
Graph program .

The GLOSSARY gives you definitions of the most
commonly used terms in the User's Guide . This serves
as a ready reference you can use to become more
familiar with terms used in the Visi On program .

An INDEX provides a quick reference to any topic in
the manual . You will find the Index particularly useful
in locating commands that are used in more than one
task .

When You're Looking at the Screen . . .
Menu commands, prompts, and messages that you see
on your computer screen appear in this guide in
"quotation marks :"

Characters that you type at your keyboard-to enter
data, for example-appear in this guide in boldface
type.

While You're Using the Program . . .
Built-in prompts and messages will guide you through
most of the basic operations . For example, the program
may ask you to supply information by typing it at the
keyboard or selecting an item with your pointer. You
can do all of the operations within the Visi On Graph
by following the instructions on the screen .
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The Visi On system is designed so that you can work
with it in a natural way . After you've become used to it,
you may need to refer to this guide only rarely to
explore some of the more sophisticated applications of
the Visi On Graph program . But, if you ever need
complete, task-oriented instructions, the Visi On Graph
User's Guide is your ready reference to the program .
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This brief chapter introduces you to the basic concepts
of the Visi On Graph TM program. You should know how
to use the basic Visi On commands, the pointing
device, and how to open and close windows as
described in the on-screen Visi On Tutorial .

If you have taken the Visi On Graph QuickStart TM
Course, you will know the basic concepts discussed in
this chapter. You can skim this chapter as a refresher
and go directly to any subject in this User's Guide that
you want to learn more about .

If you are completely new to the Visi On Graph
program, you should read this chapter for a basic
understanding of the Visi On Graph program, how it is
used, and what steps you should take to get started
using the program .

What Is the Visi On GraphTM Program?
The Visi On Graph program allows you to create
meaningful graphic displays based on your
information . A powerful editor lets you enter and
manage your numeric information, while the heart of
the program takes this information and creates bar, line,
area, pie, X-Y, and high-low-close graphs . You have
instant control over display options, deciding whether
to add grids, shading, framing, and others . You can
easily create, move, and remove labels on your graphs .
The files system lets you save all of your work, from
your basic numeric information to your completed
graphs, for use in a later session .

The Visi On Graph program can accurately plot each
specific value and automatically register its horizontal
and vertical position. You only need to enter your
numbers and choose a graph type; the program does
the rest . If your values change, use the program editor
to replace the current values with the new figures .
Redrawing your graph is simple after that . You can play
"what if . . . " trying out different numbers and graph
types until you decide on just the right manner of
presentation you need .
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How Do You Use the Visi On GraphTM Program?

The Visi On Graph program allows you to work with
24 different sets of information (up to 24,000 values
total-one thousand per set) at a time, using up to 12 of
them in a graph . You can keep eight graphs ready to
print at any time. Through use of the files system, you
can keep an almost unlimited number of either, ready
at a moment's notice .

With the Visi On Graph program you have an array of
commands and design features that make the program
easy to use and responsive to your creative needs and,
as with all Visi On programs, you simply point at
commands and options to make the program do what
you want it to do .

You use the Visi On Graph program in two basic ways :

• You enter data directly by typing it into the program
editor, or import values from other Visi On programs
by using the Visi On "TRANSFER" command .

•

	

You then select a graph type and plot the graph,
optionally changing or adding display options to
enhance and clarify your graph . Each command that
you select either leads you through a special
sequence of choices or gives you another set of
choices that you can pick . You can choose
commands quickly with the pointer.

Typing in data (entering it) is generally straightforward .
The program offers special ways to enter data in the
most efficient manner. Here we will give you an
overview of the Visi On Graph basic commands . Each
command is discussed in detail in the appropriate
chapter of this User's Guide .

When you first open a Visi On Graph window and
view the initial screen, you see the main menu at the
bottom of the window. The main menu has ten
commands that let you do various tasks with the
Visi On Graph program. Commands that are spelled
with an initial capital letter have an Options sheet that
is displayed when you select "OPTIONS" from the
Visi On menu line. These options let you set special
characteristics for your graphs .
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The basic Visi On Graph commands from the main
menu are:

data

	

The "data" command lets you select
information to be plotted as a graph or
previously plotted graphs to be
displayed .

style

	

The "style" command allows you to
choose the type of graph that will be
plotted .

plot

	

The "plot" command draws the graph
using the selected information and
style of graph .

Annotate

	

The "Annotate" command lets you
add labels to a plotted graph .

Edit

	

The "Edit" command lets you enter
your information in organized series .

Print

	

The "Print" command lets you specify
what you want to print and prints it
out for you so that you can have a
paper copy of your work for reports or
presentations .

erase The "erase" command clears the
currently plotted graph from the
display.

rescale

	

The "rescale" command lets you
change the maximum and minimum
heights and widths that will be
plotted in the graph .

file

	

The "file" command lets you store
your series and graphs permanently
on hard disk. When you are creating
or revising a series or graph, it is only
temporarily in computer memory and
must be stored permanently if you
want to reuse it in the future .

quit

	

The "quit" command makes it
possible for you to remove the Visi On
Graph window from the Visi On
screen .



1-4 Overview

Commands that begin with an initial capital letter have
an options sheet that is displayed when you select
"OPTIONS" from the Visi On menu line . These options
let you set special characteristics for your graphs that
are associated with the command that you chose ; for
example, Graph options let you alter or enhance the
currently displayed graph .

The Visi On Graph commands are grouped in menus
so that one menu logically follows another when you
do a particular task (see Figure 1-1) . Options are
displayed in vertical strips, or sheets, that are available
with each corresponding menu (see Figure 1-2) . It's a
straightforward, commonsense structure that you will
find easy to use as you learn the Visi On Graph
program .

Using Visi On GraphTM Menus

Figure 1-3. To select
a new graph to
display, follow this
typical Visi On Graph
menu path .

Now that you are familiar with what the commands do,
how do you actually use them to do various tasks? You
perform tasks in the Visi On Graph program by
selecting commands from one or more menus . For
example, if you want to select a line graph type to be
plotted in your next graph :

1. Select "style" from the Graph main menu .

2 . Select "line" from the graph style menu .

3. Select "line" from the line style menu .

Figure 1-3 shows you the menus you would use for this
example.







Figure 1-2 .
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Quitting the Program 1 -9

As you use a menu path (sequence of menus), notice
that it tells you where you are in the program. After the
program completes a command, the program returns
you to the menu from which you selected that
command .

For example, when you finish selecting a new graph to
display, you are returned to the Graph main menu .
From there you could perform other tasks or leave the
Visi On Graph program. You can go from menu to
menu by selecting the name of the menu from the
menu path line above the command line or by selecting
menu items that begin with capital letters .

Figure 1-4 illustrates the general use of the Visi On
Graph program.

When you decide to leave the Visi On'" Graph program,
select "quit" from the Graph main menu . If you have
any series and graphs that you have not yet saved, the
program tells you that you haven1 saved some files and
asks you if you want to save these series and/or graphs
before leaving the program . If you do not care what
happens to these new or revised series, you select "no"
and exit the program . If you want to save your series
and graphs, you select "yes" from the menu and a Files
display appears .

You save a series or graph from this menu just as you
do from the Files display when you are saving new or
revised series and graphs . Generally :

•

	

Select which folder you want the series or graph to
be saved in .

•

	

Select the series or graph you want to save .

•

	

Decide whether you want to save the series or graph
as a new item or to replace an existing item .

•

	

Type in the new name or accept the old name .

Repeat this procedure until you have saved all of the
series and graphs you want .

You can then select "done" from the Files display menu
to return to the Graph main menu and quit the
program .
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Figure 1-4. The Visi On Graph program can be used in a number of ways, each tailored to
your particular needs. Whether you are entering your values directly, or transferring them
from another program, the Visi On Graph program lets you manage the information and
choose the best way to display and print your graphs .
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Summing up
This overview of the Visi On Graph program provides
the basic concepts necessary to understand what the
Visi On Graph program can do for you and how the
program works .

If you have not taken the Visi On Graph QuickStart
Course, you should do so before proceeding with the
rest of this manual . Use the Visi On Setup Guide for
instructions on how to get your program ready to be
used .

After the QuickStart Course, you have several options
open to you :

∎ Start using the Visi On Graph program on your own
immediately. Refer to this User's Guide only when
you need help with specific procedures . Otherwise
read the prompt messages that guide you through
most operations or select "HELP" whenever you
need assistance in doing or understanding a task .
This manual was designed for flexible access to
information about the program . Each chapter is
independent and need not be read in order. Topics
related to each other are grouped together and
treated in a step-by-step manner . Use this manual as
your need arises .

∎ Go to the Exercises chapter in the manual if you
would like more practice creating different types of
graphs using the program . There are many types of
graphs available to you, however, and you should
not feel that you must try them all before
proceeding. Most can be learned as you go.

Figure 1-5 illustrates the tools available to you while you
learn and use the Visi On Graph program .
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Figure 1-5. The Visi On Graph Users Guide, Visi On Graph QuickStart Course, and
Visi On "HELP" command are always available to you while you learn and use the program .
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Introduction

Overview 2-1

After you create series and graphs with the Visi On
Graph' program, you'll usually want to use them
again at a later time. To do this, you need a permanent
copy that you can get easily any time you want it . This
chapter shows you how to save series and graphs and
get them from the Visi On Graph filing system . In
addition, it shows you how you can organize these files
(saved series and graphs) into folders for efficient use .

Saving, Getting, and Organizing Series
and Graphs : An Overview

In this section, we describe the basic concepts of
saving, getting, and organizing series and graphs into
folders. Later in this chapter, exact instructions are
given for each procedure .

You save a series or graph when you want to keep a
permanent record of it . When you are creating or
changing previously saved series or graphs, the new or
changed item has not been not permanently stored . If
you turn off the computer or remove the series or
graphs, you lose the information that has not been
saved . To save the new or changed series or graph you
use the Visi On Graph "file" command .

You get a saved series or graph when you want to use it
again by selecting "file" from the Graph main menu .
When you get a saved graph, all of the series that were
originally used to create it are automatically gotten as
well.

When you select the "file" command from the Graph
main menu to save or get a series or graph, the Files
display appears (see Figure 2-1) . The Files display is the
heart of the storage and retrieval system .

The Files display is your view into the Visi On Graph
Archives, your personal filing system for series and
graphs you create. The Visi On Graph Files display is
basically the same as all Visi On Files displays .
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Figure 2-1 . The Visi On Graph Files display is where you save
series and graphs permanently, get series and graphs to work on
(put them in the working folder), and organize series and graphs
into folders .

The bottom part of the Files display-the working
folder-shows a list of the series and graphs that you
put into the working folder by selecting them from the
middle part of the Files display, or that you created
during your use of the program . An asterisk (*) next to
a series or graph is the program's way of telling you
that a series or graph has not been saved since its
creation or last modification . To save it, simply select it
from the working folder and follow the prompt
messages (exact procedures are described later in this
chapter) .
The middle part of the Files display is where a saved
series or graph is put for permanent storage . It also is
where you select a saved series or graph to get it for the
working folder so you can work on it . You can, if you
want, save all of your series and graphs here without
ever using the top part of the Files display . In this case,
all of your series and graphs are saved in one central
folder called the Archives central folder.

However, the top part of the Files display lets you
organize files (saved series and graphs) into folders. A



Figure 2-2 . Use the bottom part of the Files display-the working
folder-for saving a series or graph that has not been saved (any
series or graph with an asterisk) and to hold series and graphs that
you want to work with or use .

folder is simply a collection of series and graphs and, if
you create them, other folders . You can create a folder,
collect related series and graphs in it, and display the
name of the folder in the top part of the Files display.

You can see the contents of a folder when you make it
the current folder by selecting the folder you want from
the top part of the Files display. When you select it, the
name of the current folder is displayed on the same line
as "[Archives] ."

Any folders in the current folder are displayed in the
top part of the Files display, and any series and graphs
in the current folder are displayed in the middle part of
the Files display. By selecting folders from the top part
to make them the current folder, you can browse
through your folders, viewing the series and graphs in
them . When you find a series or graph you want to
work with, you select it from the middle part, and a
copy of it is put in the working folder. The process of
organizing your series and graphs into folders is
illustrated in Figure 2-3 .

Overview 2- 3
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Figure 2-3 . The top part of the Files display is used for creating
folders for collecting related series and graphs .

At the bottom of the Files display are the Visi On Graph
Files display commands . In brief, these commands let
you do the following operations :

get-by-name

	

Lets you type in the name of any file
you want to get out of storage by its
exact name. This lets you get a file that
is inside a folder (or several folders)
without browsing through all the
folders to search for it . However, you
must know the folder(s) in which the
file is saved and you must type in
their names and the file names.

remove

	

Lets you select series and graphs that
you want to erase from the working
folder and from the middle part of the
Files display. Removing a series or
graph completely erases it from either
the working or current folder. The last
item that was removed may be
retrieved from the wastebasket (see
"Getting a File out of the
Wastebasket" in Chapter 5 of the
Visi On User's Guide for exact
procedures) .
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create-folder

	

Lets you name a new folder. When
you name it, it becomes the current
folder and you can put series and
graphs into it .

done

	

Lets you return to the Graph main
menu .

With this overview of the Visi On Graph Files display,
we can now describe the specific steps you take to save,
get, and organize your series and graphs for easy
handling.

Saving a Visi On Graph" Series or Graph
After you have created a new series or graph, you begin
to save it by selecting "file" and viewing the Files
display. While you are creating or revising a series or
graph, you may want to periodically save it so that your
work is not lost, for example, in case of a power failure .
The procedures for saving a new series or graph are
slightly different from the procedures for saving a
revised series or graph that has been saved previously.

When you save a series or graph, you may rename it .
The series or graph is filed under this name or the
name you gave it when you created it . File names can
have up to 12 alphanumeric characters and can contain
spaces between characters .

The Files display working folder contains the series or
graphs that you have available to work on . The unsaved
series and graphs you have created or modified are
indicated by an asterisk (*) beside the name of the
series or graph .

The differences in the way you save new and revised
series and graphs have to do with naming the series or
graph you want to save .

Saving a New Series or Graph
Whenever a new series is created in the Edit display, its
name is automatically listed in the working folder . From
there it may be permanently saved in the current folder .
Graphs, on the other hand, must be frozen before they
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appear in the working folder and can be permanently
saved.

If you are saving series without saving graphs, you can
go directly to "Saving series and graphs" later in this
section .

Freezing graphs
Graphs must be frozen before they appear in the
working folder and can be permanently saved . A frozen
graph is more than the picture you have created in the
Graph display. Each stored graph keeps a record of the
series that were used to create it, the option settings,
the annotation, and the scale and range of the graph .
Frozen graphs can also be used when you print your
graphs on paper. (See Chapter 6, "Printing;" for more
information .)

There are two steps in saving a graph . In the first step
you freeze the current graph, temporarily saving it in
the working folder. In the second step you save the
working folder copy of the frozen graph in the current
folder. The second step does not have to be done
immediately after the first, but must be done before you
quit the Visi On Graph program .

Begin this process in the Graph display with the graph
you want to freeze showing .

To freeze a graph 1. Select "data" from the Graph main menu .

2 . Select "graph" from the data menu .

3. Select "freeze ."

4. Type a name for the frozen graph page, followed by

5. The graph is temporarily saved in the working folder
and you are returned to the Graph main menu .

The frozen graph is temporarily saved in the working
folder, the contents of which will be lost when you
leave the Visi On system . If you want to put the graph
into an permanent archives folder, follow the steps in
"Saving series and graphs ."
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Saving series and graphs
To save a new

	

1. Select from the top part of the Files display the
series or graph

	

folder that you want the series or graph to be saved
in . The folder you select becomes the current folder,
and its name displays as the last name on the
Archives line. If the folder you want to use is already
the current folder you may skip this step .
∎

	

If you want to save your series or graph in a new
folder, select "create-folder," type in the folder
name, and press (ENTER). The series or graph will be
saved in this folder .

∎ If you have no folders and you don t want to save
the series or graph in a specially named folder,
select "[Archives]" from the top part of the Files
display. The series or graphs will be saved in the
Archives central folder when you complete the
following steps .

2 . The series and graphs are displayed in the working
folder. To save a series or graph, select its name from
the working folder.

3. You have two choices for naming your series or
graph file :
∎ If you want to create a new name for your series

or graph file, select "create" from the menu line .
(If you wish to use the default name, press (ENTER),
and the name of your file will be default name.)
-Type up to 12 characters for the new name that

you want . You can use the (D EL) and
keys to delete single characters or the
key to delete the entire line . Do not type in the
name of any file that already exists in the
current folder unless you want to replace that
file with this new file, as that old file will be
removed . (In some cases the old file can be
retrieved from the wastebasket . See "Getting a
File out of the Wastebasket" in Chapter 5 of the
Visi On User's Guide .) Press (ENTER) after you have
typed the name .

(BKSP
(E N D)
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After you have saved a series or graph, then later revise
it, you will likely want to save it again . The procedure
for doing this is similar to saving a new series or graph,
but because in this case the series or graph already has
a name, the steps you take to name the series or graph
can be slightly different, depending on whether you
want to completely replace the original or to keep both
the original and the revised version .

If you want to completely replace the original saved
series or graph with the modified series or graph, the
steps are simple. Select the "file" command from the
Graph main menu; then follow these steps:

To replace a

	

1. Select from the working folder the name of the
saved series or

	

series or graph .
graph

	

2. Select "replace" from the menu line .
It is that simple. You do not need to be concerned

-Alternatively, you can save a series or graph in
a folder that is not the current folder . Type the
folder name first, followed by a slash (/), and
then the series or graph name you want . If you
have created folders within folders, type in all
folder names first, separated by slashes, and
then the series or graph name you want . See
the section "Organizing Your Series and
Graphs" for details on creating folders .

∎ If you want the series or graph to replace a file
that is displayed in the middle part of the Files
display, select the name you want from the
middle part . The file in the middle part will be
replaced by the series or graph you selected from
the working folder. It is displayed in the middle
part, and it retains the name of the file in the
middle part .

4. Your series or graph is saved permanently in the
current folder. A copy of the same series or graph
remains in the working folder. You can now return to
the Graph main menu by selecting "done" from the
Files display menu . You may also get a saved series
or graph in the working folder for revisions . See the
appropriate sections under "Getting a Visi On
Graph Series or Graph ."

Saving a Revised Series or Graph
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about folders. The program finds the original saved
series or graph automatically even if it is not in the
currently displayed folder and replaces it with the
series or graph that you selected from the working
folder. The original series or graph is gone, but you
can even retrieve the original under some
circumstances (see "Getting a File out of the
Wastebasket" in Chapter 5 of the Visi On User's Guide
for exact procedures) . The series or graph that is
now saved retains the name of the original .

Your series or graph is saved permanently in its original
folder. A copy of the series or graph remains in the
working folder. You can now return to the Graph main
menu by selecting "done' from the Files display menu .
You can keep track of each version of a series or graph
that you create by giving each revised series or graph a
related but different name ; for example, Sales 1,
Sales 2, Sales 3 . If you want to preserve the original
saved series or graph and save the revised version also,
follow these steps after you have selected "file" from
the Graph main menu :

To save both

	

1. Select from the top part of the Files display the
versions

	

folder that you want the series or graph to be saved
in . In this case, you will likely want to select the
folder that has in it the original series or graph . The
folder you select becomes the current folder, and its
name displays as the last name on the Archives line .
∎ If you don t select a folder, the series or graph

will be saved in the folder that is currently
displayed .

∎ If you want to save your series or graph in a new
folder, select "create-folder," type in the folder
name, and press (ENTER) The series or graph will be
saved in this folder.

∎ If you have no folders and you don t want to save
the series or graph in a specially named folder,
select "[Archives]" from the top part of the Files
display. The series or graph will be saved in the
Archives central folder when you complete the
following steps .

2. Select the series or graph from the working folder .

3. To create a new name for your series or graph file,
select "create" from the menu line .
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(You could have selected a name from the middle
part of the Files display, but the series or graph
would then be saved under that name . You could
have also replaced the original, but in this case, you
want to preserve the original and save the revision .)

4. Type up to 12 characters for the new name that you
want . You can use the (D E L) and (B K S P) keys to
delete single characters or the (E N D) key to delete
the entire line.
Do not use the default name or type in the name of
any file that already exists in the current folder
unless you want to overwrite that file with the new
file. The old file may be lost . (In some cases the old
file can be retrieved from the wastebasket . See
"Getting a File out of the Wastebasket" in Chapter 5
of the Visi On User's Guide .)
You can distinguish this name from the original by
simply adding a number or letter to indicate it is a
revision . For example, if the original name was Sales,
you can name this revision Sales1 .

5. Press

Your series or graph is saved permanently in the
current folder you selected . A copy of the series or
graph remains in the working folder .

You can now return to the Graph main menu by
selecting "done" from the Files display menu . You may
also get a saved series or graph in the working folder
for revisions . See the appropriate sections under
"Getting a Visi On Graph Series or Graph ."

Saving a Series or Graph When You Quit the Program
When you decide to leave the Visi On Graph program,
select "quit" from the Graph main menu . If you have
any series and graphs that you have not yet saved, the
program tells you that you haven t saved some files and
asks you if you want to save these series and/or graphs
before leaving the program. If you do not care what
happens to these new or revised series, you select "no"
and exit the program. If you want to save your series
and graphs, you select "yes" from the menu and a Files
display appears .
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You save a series or graph from this menu just as you
do from the Files display when you are saving new or
revised series and graphs . Generally :

•

	

Select which folder you want the series or graph to
be saved in .

•

	

Select the series or graph you want to save .

•

	

Decide whether you want to save the series or graph
as a new item or to replace an existing item .

•

	

Type in the new name or accept the old name .

Repeat this procedure until you have saved all of the
series and graphs you want .

You can then select "done" from the Files display menu
to return to the Graph main menu and quit the
program .

Getting a Visi On GraphTM Series or Graph
You get a series or graph when you want to use or
modify one that has been saved . Getting a series or
graph puts it into the working folder . You can only get a
series or graph from the current folder. Getting a series
or graph does not remove it from storage, but makes a
copy of it in the working folder for you to work with .

The general procedure for getting a series or graph is to
go to the Files display, browse through the contents of
the folders until you find the series or graph you want,
select the series or graph from the middle part of the
Files display, then select "done" from the Files display
menu. You can also get a series or graph directly by
using the "get-by-name" command of the Files display.
In this case, you must know the series or graph name
and the names of any folders it is in .

When you get a graph, the series that were used to
create that graph are automatically copied into the
current folder along with the graph .

There can be a maximum of 24 series and eight graphs
in the working folder . If there are already 24 series or
eight graphs in the working folder, you will have to
remove some of them before getting more series or
graphs.
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Sometimes it is handy to get several series and graphs
for the working folder before you work on any one of
them . The series or graphs that you select are displayed
in the working folder, ready to be used .

You can get a series or graph by selecting "file" from
the Graph main menu .

Getting a Series or Graph by Looking
through Your Folders

When you don't know the exact file name of the series
or graph, you get its name by looking through the
folders until you see it . From the Files display, you
follow these steps :

To browse

	

1. If your series or graph is stored in the Archives
through the

	

central folder, select the series or graph you want
Archives folders

	

from the middle part of the Files display. (Scroll the
middle part up to view all of the series and graphs
that are in the middle part .)
∎ If your series or graph is stored in a folder other

than the Archives central folder, select that folder
from the top part of the Files display. That folder
becomes the current folder and displays the
series and graphs that are in it in the middle part
of the Files display. Select the series or graph you
want from the middle part .

∎ If you are not sure which folder the series or
graph you want is saved in, select "[Archives]"
from the top part of the Files display .
- Select a folder and view its contents in the

middle part .
-Continue to select folders, viewing each folder's

series and graphs, until you find the series or
graph you want .

-Select the series or graph .

2 . The series or graphs you select are copied into the
working folder. You can now continue to get series
and graphs in this manner, or select "done" from the
Files display menu and return to the Graph main
menu .



Getting a Series or Graph by Name
You get a series or graph directly by name when you
know the folder names in which the series or graph is
saved and the series or graph name . You simply type in
the folder names first, then a slash (/), then the series
or graph name. Getting by name saves you time by not
requiring you to browse through your folders.

Follow these steps to get a series or graph by its name
after you have selected "file" from the Graph main
menu :

To get a series or 1. Select "get-by-name" from the Files display menu .
graph by name

	

The prompt line asks you to enter a series or graph
name.

2 . Type in the folder name (type in all folder names if
the series or graph you want is filed inside another
folder; separate each folder name with a slash) . For
example, if the series or graph you want is filed in
the folder Sales and in the folder in /Sales named
West, you would type in Sales/West . Then type in
the series or graph name ; for example, if the name of
the series or graph is Territory1, the full name that
you would type in is /Sales/West/Territory1 .

3. Press( ENTER ).
The series or graph you want is retrieved from the
folder and displayed in the working folder .
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4. Select "done" if you are finished getting series
and graphs .
(Before you select "done" you can also get by name
other series and graphs for the working folder or by
browsing through your folders. You can also perform
other Files display activities such as saving unsaved
series and graphs or removing files .)

Organizing Your Series and Graphs
Before long, you will have collected a large number of
series and graphs. This section explains how to keep
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Creating Folders

To create a folder

track of your series and graphs by organizing them
within the Visi On Graph filing system . Using the
instructions in this section, you can logically group
series and graphs so they will be easy to retrieve
and use .

Organizing Your Series and Graphs: An Overview
The Visi On Graph filing system allows you to group
related series and graphs together as you would in a
normal filing system .

In a normal filing system, you might have a folder
named Sales . This folder might contain other folders,
for example Sales/West and Sales/East . And inside the
Sales/West folder, you might have a folder called
Territories and a series or graph called Total Sales/West .

The Visi On Graph filing system works the same way .
You can create a folder named Sales . You can then place
other folders, such as Sales/West, in that folder . And,
just as you would in a normal filing system, you can
then place other folders and series and graphs in the
Sales/West folder. Figure 21 illustrates the way you
organize series and graphs in the Visi On Graph
filing system .

Grouping related series and graphs and folders in a
single folder is the best way to organize your files . The
"create-folder" command creates the folders you need
for this task .

1. Select "file" from the Graph main menu .

2 . Then do one of the following :
∎ If you want to create a folder in the Archives

central folder, the central folder must the current
folder.
To check this, look at the top line of the file
display screen . It should contain only the word
"[Archives] ." If it reads differently-for instance,
"[Archives] /Folder1'--then the Archives central
folder is not the current folder. To open it, select
"[Archives]" from the top part of the Files display
before creating your new folder .



Figure 2-4. The
Visi On Graph filing
system lets you
organize your files just
as you would in a
normal filing system .
Related series and
graphs are collected in
folders; related folders,
series, and graphs are
collected in other
folders .

Organizing Your Series and Graphs 2-1 5



2-1 6 Saving, Getting, and Organizing Series and Graphs

To move a series
or graph from
one folder to
another

When the Archives central folder is the current
folder, select "create-folder" from the File menu .

∎ If you want to create a new folder within an
existing folder, select "create-folder" while that
folder is the current folder .
The folder that is currently open is listed after
"[Archives]" in the top part of the Files display .
For example, if the top line reads
"[Archives]/Folder1," then Folder1 is the current
folder.

You are prompted to give the new folder a name .

3. Type in a name up to 12 characters long.

4. Then type (ENTER) .
The new folder is created and you are returned to
the Files menu .

Placing Series and Graphs in Folders
You can place a series or graph in a folder two ways :

•

	

Save the series or graph while the folder you want it
in is the current folder ; or

•

	

Save the series or graph by typing the folder name
first, followed by a slash (/), and then the series or
graph name you want . If you have created folders
within folders, type in all folder names first,
separated by slashes, and then the series or graph
name you want .
For example, if the Files display shows that the
Archives central folder is currently open, but you
want to save a series or graph called Sales in Folder1,
you would create a series or graph called
"Folder1/Sales." If you subsequently opened Folder1,
you would see that it now contains a series or graph
called Sales .

1 . Make the folder containing the series or graph you
want to move the current folder .

2. Select from the middle part of the Files display the
series or graph you want to move . This places that
series or graph in the working folder .

3. Select "[Archives] ." This makes the Archives central
folder the current folder .
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4. Browse to and select the folder you want the series
or graph moved to .

5. When this folder is the current folder, select the
series or graph you want moved from the bottom
part of the Files display .

6. You are asked whether you want to create a name for
the series or graph you want to move in the current
folder, or to replace the series or graph in its original
folder. Select "create" to place a copy of the series or
graph in the current folder.

7. After you select "create,' you are asked to enter a
series or graph name . Type in a new name and press

(ENTER), or simply press (ENTER ) to keep the same name .

8. The current folder now contains a copy of the series
or graph. If you want to remove the series or graph
from the folder that originally contained it, browse
back to that folder and select "remove ." See the
section in this chapter on "Removing Series and
Graphs" for details .

Removing Folders
A folder must be removed through the Visi On
Archives utility. See Chapter 5 of the Visi On User's
Guide for instructions on how to do this.

Removing Series and Graphs
It is a good idea to get rid of outdated or redundant
series and graphs from time to time . Removing series
and graphs keeps your file system uncluttered and easy
to use .

For a series or graph to be removed, it must be present
in either the middle or bottom part of the Files display .
You must therefore (1) open the folder containing the
series or graph you want removed ; then (2) remove
(using the following instructions) the series or graph
you want removed in the current or working folder .

Remember that the names in the current folder
represent series and graphs that you have previously
saved. Removing these names from the current folder
removes them from permanent storage . The names in
the working folder represent series and graphs that
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might be lost if they are removed without being saved
first in the current folder . (In some cases the removed
series or graph can be retrieved from the wastebasket.
See "Getting a File out of the Wastebasket" in Chapter 5
of the Visi On User's Guide.)

You must begin this process in the Files display with
the series and/or graphs you want to remove in the
current folder.

To remove series 1 . Select "remove" from the Files menu.
or graphs

	

You are prompted to select a series or graph you
want to remove or select done .

2. Select a series or graph you want removed .
∎ If you selected a series or graph in the middle

part of the Files display, you are asked to either
select another series or graph from the middle
part of the display or select "done ."
If you selected a series or graph from the bottom
part of the Files display, you are asked to either
select another series or graph from the bottom
part of the display or select "done ."

You may not remove series and graphs from both the
middle and bottom part of the Files display at one
time . Remove series and graphs from one first, then
the other.
The series or graph or series and graphs you select
are highlighted .

3. Select "done" when you have finished selecting
series and graphs to be removed .
You are prompted to confirm whether you really
want to remove the series and graphs you have
selected .

4. Select "yes" if you do . If you do not want to remove
the highlighted series and graphs, select "no."
When the series and graphs have been removed,
they disappear from the Files display.

The series or graphs are gone . If you have removed a
series or graph from the current folder and realize later
that you have made a mistake and need it back, you
can retrieve it under some circumstances (see "Getting
a File out of the Wastebasket" in Chapter 5 of the
Visi On User's Guide for exact procedures) .
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The Visi On Graph program allows you to easily
convert your information into easily understood
graphs . However, before it can be used in a graph, your
information must be entered into the program .

The numbers that you use in charts and graphs must
first be organized so that the final graph presents
meaningful information, not just random numbers . In
the Visi On Graph program, such information must be
organized into a series . A series is a sequence of values
that are recorded at regular intervals, all referring to a
common subject .

Series values represent relationships between things
and events, and are usually expressed in chronological
order. For example :

•

	

If total sales are reported for twelve successive
months, those twelve totals are a series .

•

	

If rainfall is measured daily for a week, those seven
measurements are a series .

•

	

If scores for different golfers in a single tournament
are reported, even though there is no reference to
time, those scores are a series .

In short, anything that you can measure can generate
series values, as long as the measurements are
expressed in the same units (dollars, feet, degrees, etc .)
These measurements, whether presented as a table of
numbers, a written summary of results, or as a graph,
can be used as a series .

For each value in a series, a "tick mark" is put on the
horizontal axis . A tick mark is a mark on the axis that
indicates the position and order in which a value is
plotted . Tick marks are sequential, starting with the
first value, leftmost on the axis, and proceeding to the
right with each additional value that is plotted . Under
the tick marks are the tick mark labels . These labels are
generated automatically by the program based on the
series periodicity.
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The periodicity of a series is a number you enter when
you first create the series . It explains to the program
what time frame is used by the series . Along with the
periodicity of the series, you enter beginning dates for
the information, called start dates . The program uses
these numbers to generate the tick mark labels that
appear on the horizontal, or X axis .
Series information is often collected over distinct time
periods. If you want to display your series information
reflecting these time periods, you can use the
periodicity to do this automatically in the program .
For example, you can display monthly information that
spans several years, starting in March 1983. For this you
set your series periodicity at 12 . The major start date
(year) would be 1983. The minor start date (month)
would be 3 (March .) The X axis of your graph would
have a one large tick mark for each successive year
displayed, with the year directly underneath . Smaller
tick marks, each one representing a month, would be
found between the yearly marks . A series value would
be plotted above both the yearly and monthly marks .
Other common periodicities can also be set . For
example, a periodicity of 7 lets you enter values on a
daily basis over several weeks . The program displays
tick marks for each daily value and marks a new week
on each seventh value .
Or, for example, a periodicity of 4 lets you enter series
values on a quarterly basis over several years . The
program displays tick marks for each quarterly value in
the series and marks each new year every fourth mark .

If, however, you do not want to have a distinct time
frame reflected in your graph, a periodicity of 1 and a
starting date of 1 will give you an evenly incremented
count of your plotted values .

The effect of series periodicity is seen in the label of a
horizontal axis. For example, the graphs in Figure 31
are all based on the same numbers, but have different
periodicities and beginning dates .

The start year is also important to periodicity. (This
number may not necessarily be a year, but the program
will request the major time frame using that term .) For
instance, yearly periodicity can be 1, but the start year
should be the first reported year (1901, 1956, 1983, etc .)
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Figure 3-1 . Different periodicities using the same series values are shown in each of these
graphs. Each uses the same values in its series but has a different periodicity and beginning
date. (1) With quarterly periodicity, reporting the quarters in a year, the period repeats with
every four values . (2) With monthly periodicity, reporting months in a year, the period
repeats every 12 values . (The Visi On Graph program generates the first letter of each month
instead of a number.) (3) Yearly periodicity uses a periodicity of 1 . All years are displayed in
the graph truncated to the last two digits .) (4) The same series with daily periodicity as 1,
with a start date of 1 .

or a number indicative of that year (such as 01, 56, or
83) should be given.

If the periodicity of the series you are editing is other
than 1, the program will request a second date for the
series, the start period. This is necessary because you
can begin your series with any period in the cycle .

Series with periodicities other than 1 have 2 distinctive
periods associated with them; the major period and the
minor period . The major period is incremented each time
the minor period completed its cycle, as is illustrated in
Figure 3-2 .
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Figure 3-2 . Both SERIES11 and SERIES22 have periodicities
other than 1, and therefore have both major and minor periods .
SERIES11 has a periodicity of 2 . Each time the minor period
completes its cycle, the major period is increased by 1 . SERIES22 has
a periodicity of 4. Its cycle is twice as long as SERIES11, and its
major period does not increment as quickly . Even though the major
period in your series may not necessarily represent years (as in
SERIES22) the Visi On Graph program will often refer to numbers
in the major period as "years ."

Not every series needs to have a distinctive periodicity .
For instance, X-Y graphs plot two series against each
other. Although they just use the same periodicity to
represent meaningful information, the axes of the
finished graph do not indicate any periodicity. Still, in
such cases, you should try to use the periodicity that
makes the most sense in the situation you are
describing (monthly, yearly, quarterly, etc) .

Creating and Changing Your Series
Whether you enter your series in at the keyboard or use
the Visi On "TRANSFER" command to bring them into
Visi On Graph program from another program, you can
use the "Edit" command in the main menu to modify
and change the series values and periodicity .

The Edit display allows you to add to and modify the
series you later plot into graphs . Figure 3-3 shows you
the major sections of the Edit display, the place where
all of the changes you make to a series take place . You
reach the Edit display by selecting "Edit" from the main
Visi On Graph menu .

SERIES 1 1 SERIES 22

major minor major minor
period period series period period series

1979 1 9,12 9 4 12 .9
2 8 .23 t8 1 23.8

1988 1 7 .34 2 34,7
2 6 .45 3 45 .6

1981 1 5,56 4 56 .5
2 4 .67 11 1 67 .4

1982 1 3 .78 2 78 .3
2 2 .89 3 89 .2

1983 1 1 .91 4 98 .1
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Figure 3-3 . The Edit display is composed of: (1)The major period
column . This value increases by one each time the minor period
column completes its cycle. (2) The minor period column . The range
of the these numbers is determined by the number you entered as the
periodicity. The periodicity used in this example is 4, so the numbers
in this column are between 1 and 4 . If the periodicity of the series is
1, there is no minor period column . (3) The series being edited . If
more than one series are being edited, they must have the same
periodicity. (4) The editing cursor determines where the next number
is going to he inserted in the series .

Unless you are transferring values into the Visi On
Graph program using the Visi On "TRANSFER"
command, you must enter the numbers you will use in
your graph in the Edit display.

This section takes you, step by step, through creating
a series .

This procedure begins in the Edit display. (Select "Edit"
from the Graph main menu to enter the Edit menu .)

There should not be any series in the Edit display at the
beginning of this procedure . If there are series in the
display, you must use the "clear" command in the Edit
menu to remove them from the display . Instructions on
using the "clear" command can be found in "Clearing
Series from the Edit Display" later in this chapter .

To create a series

	

1. Select "series."
Any of your current series names are displayed
along with "new series" (see Figure 3-4) .



3-6 Creating Series

Figure 3-4 . The select series menu line displays the names of any
series in your current folder .

2 . Select "new series."
If you selected something other than "new series"
by mistake, you can select "start-over" to cancel the
selection . After you select "start-over,' select the
"new series" command .

3 . Select "done ."
The program asks you how many new series you
are entering .

4 . If you are entering :
∎ One series : press ( ENTER) to accept the preset value

of one series .
Several series : Type the number of new series
(depending upon window size, up to 12 can be
edited at the same time) you are entering and
press ( ENTER) . The program will repeat steps 6
through 8 below for each of the series you
are entering.

The program requests the periodicity for your series . If
you are entering more than one series, that periodicity
will be used in all of the new series . (See "Periodicity"
earlier in this chapter for additional information .)

5. Type the series periodicity followed by (ENTER), or press
(ENTER) to accept the preset periodicity .
∎ The periodicity can be any number between 1

and 99.
∎ The preset periodicity is 1 .
∎ The value you choose is used as the periodicity

of all the series you are entering .
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The questions in steps 6 through 8 will be repeated
for each series .
The program asks you to enter a name for the series
series or accept the preset name.

6 . Type each value or name followed by (ENTER), or accept
the preset value or name by pressing (ENTER) alone.
The program asks for a start year for the series .

7. Type the beginning year value or date (1983,
84, etc .) and press (ENTER), or press (ENTER) to accept the
preset year.
If your periodicity is a number other than 1, the
program prompts you for a beginning period . For
example, you may be entering numbers for 1983 that
begin in March . When the program asks you for the
beginning period for your series, you would enter 3
because March is the third month in the year .

8. Type the beginning period value and press (ENTER), or
press ( ENTER) to accept the preset year.
The beginning period value must be between one
and the value you entered as your periodicity .

9. Select "add ."
The program prompts you to select the location for
the new values .

10. Select the word "empty" under the first series you
want to fill with numbers .
You are prompted to enter numbers, select a new
location, or select "done" when you are finished .

11. Type the first number in your first series and
press (ENTER).

Continue to enter all of your numbers in this first series
in this way : type each number and press (ENTER) to enter
the number and advance the cursor down to the next
entry position .

If you are editing more than one series :
You may select, as in step 10, any of the other
series at any time . The editing cursor will move
to that series and you can begin entering
numbers into that series .
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Figure 3-5. Each area of the Edit display provides you with
information about the series you are editing . The leftmost column
shows the period for each of the corresponding rows . To the right of
this column is the series entry area . Each series name heads the
series column . If you are editing more than 1 series, additional series
are displayed in columns to the right .

∎ If you want to continue making entries into a
series after you have left it, select the row just
below the last entry you made in the series. The
cursor moves to the bottom of this series and
you can continue making your entries .

∎ If you make a mistake while typing a number,
you can use the backspace key to correct it . If
you realize that you have made a mistake after
you have already pressed ( ENTER ), you can correct it
by following the procedures in "Replacing
Numbers in a Series" and "Removing Numbers
from a Series" later in this chapter .

12. When you have finished entering numbers, select
"done."

These complete series are added to your working folder
when you leave or clear the edit display . You can now
save the series (see Chapter 2, "Saving, Getting, and
Organizing Series and Graphs ;" for more information
about the working folder and saving your series), plot
them as a graph (see Chapter 4, "Turning Series into
Graphs"), or continue to modify them using any of the
techniques discussed in this chapter .

Adding Numbers to the End of a Series
You can add numbers to a series in two ways : by
adding to the end of the series, which is discussed in
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Figure 3-6. After you select "series" from the menu the names of
all of the series in the working folder are displayed .

this section, and by inserting new numbers between
existing numbers . (Inserting numbers into an existing
series is discussed in "Inserting Numbers into a Series"
later in this chapter.)

This procedure begins in the Edit display. (Select "Edit"
from the main menu to enter the Edit display .)

To add numbers

	

1. Select "series ."
to a series 2 . Select the name of each series to which you want to

add numbers, as illustrated in Figure 3-6 .

If you are adding numbers to more than one series, the
series must have the same periodicity. If the series
periodicities do not match, the program will show an
error message .

If by mistake you selected a series that you did not
want, you can select "start-over" to begin selecting
your series again .

3. Select "done ."
The Edit display shows the series you have selected .
Because you are adding numbers to this series, you
need to be able to see the last entry .

4. If the series extends below the bottom of the display,
select "goto" from the menu line .
The program asks you to select the location you
want to see in the series .

5. Select "ending ."
The last entry in all of the series is scrolled to the
middle of the Edit display .
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6. Select "add ."
The program asks you to select the location where
you are adding values .

7. Select the blank row below your last entry in
this series .

8. Type each number you wish to add and press (ENTER)
after each . The number is entered into the series and
the cursor moves down to the next row.

Removing Numbers from a Series

To remove
numbers from a
series

9. When you have finished entering numbers, select
"done ."

The changes you have made in the Edit display are
made to each of these series in your working folder
when you leave or clear the Edit display. You can now
save the series (see Chapter 2, "Saving, Getting, and
Organizing Series and Graphs;" for more information
about the working folder and saving your series), plot
them as a graph (see Chapter 4, "Turning Series into
Graphs"), or continue to modify them using any of the
techniques discussed in this chapter .

Occasionally you will find that some of your numbers
will need to be removed from a series, or multiple
series. The "delete" command allows you to remove
numbers from series. If, however, you are going to
replace those values with an equal number of new
values, you should use the "replace" command,
described later in this chapter .

Figure 3-7 illustrates the effect of using the "delete"
command .

This procedure begins in the Edit display. (Select "Edit"
from the main menu to enter the Edit display.)

1. Select "series."

2 . Select the names of the series you want to remove
numbers from .
If you selected a series that you did not want by
mistake, you can select "start-over" to begin selecting
your series again .
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3. Select "done ."

4. Select "delete ."

Figure 3-7. When numbers are removed from a series using the
"delete" command, the numbers that follow are moved up .to fill the
empty space.

5. Select the first number (highest and leftmost) you
want to remove .

6. Select the last number (lowest and rightmost) you
want to remove . If you are only removing one
number, select that number again .

Note : If either number is above or below the rows
currently displayed on the screen, scroll that number
into the display and select it .

The rectangle of numbers to be deleted is
highlighted. The prompt line asks if you want to
delete this area .
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Replacing Numbers in a Series

To replace
numbers in a
series

7. Review the highlighted range and :
∎ Select "yes" if the highlighted range is correct .

The highlighted numbers are removed .
∎ Select "no" if the highlighted range is incorrect .

The highlighting is removed and the series is not
changed . If you still want to remove numbers
from this series, begin again at step 4 .

The changes you have made in the Edit display are
made to each of these series in your working folder
when you leave or clear the Edit display. You can now
save the series (see Chapter 2, "Saving, Getting, and
Organizing Series and Graphs ;" for more information
about the working folder and saving your series), plot
them as a graph (see Chapter 4, "Turning Series into
Graphs"), or continue to modify them using any of the
techniques discussed in this chapter .

Occasionally you will find that some of your numbers
will need to be replaced with new values . The "replace"
command allows you to replace numbers at the
beginning, end, or in the middle of a series without
moving the rest of the series .

Figure 3-8 illustrates the effect of using the "replace"
command.

This procedure begins in the Edit display. (Select "Edit"
from the main menu to enter the Edit display.)

1. Select "series."

2. Select the series in which you wish to replace
numbers .
If you selected a series that you did not want by
mistake, you can select "start-over" to begin selecting
your series again . .

3. Select "done ."

4. Select "replace ."
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Figure 3-8. The "replace" command does not affect numbers in the
series other than those that are changed .

5. Select the first number that you are going to replace .
The cursor highlights this number and the program
asks you for a new number .

6. Type the replacement numbers entering each with
(ENTER). After each (ENTER) the cursor moves down one row
and the program asks you for a new number.
∎ If you are replacing numbers in more than one

series, you can use the arrow keys to move the
cursor to the other series or select any number in
the Edit display to move the cursor directly to
that position .

∎ If you want to keep the current highlighted
number, just type (ENTER). The cursor will leave the
current value in that position and move down to
the next entry.
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7. When you have finished replacing numbers, select
"done."

The changes you have made in the Edit display are
made to each of these series in your working folder
when you leave or clear the Edit display. You can now
save the series (see Chapter 2, "Saving, Getting, and
Organizing Series and Graphs;" for more information
about the working folder and saving your series), plot
them as a graph (see Chapter 4, "Turning Series into
Graphs"), or continue to modify them using any of the
techniques discussed in this chapter .

Inserting Numbers into a Series
Occasionally you will find that you need to insert
numbers into the body of a series. Rather than replace
the numbers that exist there, you need to insert
numbers before or after them . The existing numbers
must be "pushed out" in the series as new numbers
are inserted .
Figure 3-9 illustrates the effect of inserting numbers into
a series .
This procedure begins in the Edit display. (Select "Edit"
from the main menu to enter the Edit display.)

To insert

	

1. From the menu line, select the name of each series
numbers into a

	

you wish to insert numbers into .
series

	

If by mistake you selected a series that you did not
want, you can select "start-over" to begin selecting
your series again .

2 . Select "done ."

3. Select "add ."
The program asks you to select the location you
want to add numbers to .

4. Select the position where you want to begin
inserting numbers .
A blank line is inserted at this location for your new
entry and the cursor highlights this line .

5. Type each number you wish to insert into the series
and press (ENTER) to enter the number.
As each number is entered, the cursor moves down



Figure 3-9 . Numbers
that are inserted into a
series "push" the
numbers that follow
them out to later
periods in the series .
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to insert a new row. The number that was there
moves down another row.
If you are editing more than one series, you can use
the arrow keys to move the cursor to the other series
or select any number in the Edit display to move the
cursor directly to that position . The cursor always
inserts a blank space into the new position and
moves the numbers below it down one row .

6. When you have finished entering numbers, select
"done."
The editing cursor is removed and the lower
numbers move up in the series to fill in the empty
location .

The changes you have made in the Edit display are
made to each of these series in your working folder
when you leave or clear the Edit display. You can now
save the series (see Chapter 2, "Saving, Getting, and
Organizing Series and Graphs ;" for more information
about the working folder and saving your series), plot
them as a graph (see Chapter 4, "Turning Series into
Graphs"), or continue to modify them using any of the
techniques discussed in this chapter .
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Moving around in a Series
A series can contain more entries than can be shown in
the Edit display at one time . If you scroll the display,
you will eventually see any number in the series, but
you can use the "goto" command to move directly to
any point in the series . The "goto" command can
immediately move you to the beginning or end of the
series, or to any specific period .

To move directly

	

1. Select "goto ."
to a new point in

	

The program asks you to choose the location you
a series in the

	

want to see . Your choices are "beginning," "ending,"
Edit display

	

and "specific-year."

2 . Do one of the following :
∎

	

Select "beginning" to move the series down until
the first number is at the top of the Edit display .

∎ Select "ending" to display the last number . The
last number in the series moves to the middle of
the Edit display .

∎ Select "specific-year." The program will ask you
which point in the series you want to view. The
program will ask you for the year (major period)
that you want to display .

∎ Type the year and press ( ENTER ).
∎ If your series has a periodicity other than one, th

program asks you for the period to display. Type
the period and press (ENTER)

The period that you have indicated is moved into the
Edit display.

Changing Series Names, Periodicities, and Dates

Occasionally you may find that the name, periodicity,
or starting date you indicated when you created a series
was wrong or does not provide you with the right type
of information. If this is the case, you can use the
"parameters" command to change it .

This procedure begins in the Edit display. (Select "Edit"
from the main menu to enter the Edit display.) You



may, however, use this command at any time to change
the name, periodicity, or start date of a series that you
are currently editing (you would begin at step 4 .)
Remember that all of the series in the Edit display must
have the same periodicity. The program will not let you
change the periodicity of one series while there are
other series in the Edit display.

To change the

	

1. Select "series :"
name,

	

2. Select the series you want to change .periodicity, or
start dates of a

	

3. Select "done ."
series

	

The series is shown in the Edit display .
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4. Select "parameters ."
If you are editing more than one series, the program
asks you if you want to change all the series or just
one. (If you are only editing one series, skip step 5 .)

5. If you are editing more than one series, select one of
the following :

∎ "all-series" if you want the changes to names,
periodicities, and start dates to affect all of the
series in the Edit display.

∎ "single-series" if you only want to change the
name and/or start dates on one of the series in
the Edit display.
If you select "single series ;" the program asks you
to select the column of the series you want to
change . Select this series .

If you are changing the parameters for "all-series ;" or if
you have only one series in the Edit display, the
program asks you to enter the new periodicity . If you
have more than one series in the Edit display and
selected "single-series" you will skip this step .

6. Do one of the following:
∎ Type the new periodicity and press (ENTER)

∎ Press (ENTER)to keep the current periodicity.

The program asks you for a new name for the series . (If
you are changing "all-series," the program highlights
each series individually.) Repeat steps 7 through 9 for
each series as it is highlighted .
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7. Do one of the following :
1 Type the new name and press (ENTER)
∎ Press (ENTER) to keep the current name .

The program asks you for a new start year for the
highlighted series.

8. Do one of the following :
∎

	

Type the new start year and press (ENTER).
∎

	

Press (ENTER) to keep the current start year .

If the series periodicity is any value other than 1, the
program asks you for a new start period .

9. Do one of the following :
∎

	

Type the new start period and press (ENTER).
∎ Press (ENTER) to keep the current start period . (If you

changed the start year, the current start period
will be 1 .)

Again, if you are changing the parameters on more
than one series, repeat steps 7 through 9 for each of the
highlighted series.

The changes you have made in the Edit display are
made to each of these series in your working folder
when you leave or clear the Edit display. You can now
save the series (see Chapter 2, "Saving, Getting, and
Organizing Series and Graphs;" for more information
about the working folder and saving your series), plot
them as a graph (see Chapter 4, "Turning Series into
Graphs"), or continue to modify them using any of the
techniques discussed in this chapter .

Having the Visi On GraphTM Program
Add Numbers to Your Series

You may sometimes want the program to generate
numbers for your series . The Visi On Graph program
calls this process a fill and lets you choose from three
different methods :

∎ Interpolation : Replaces a range of zero values with
new entries that are evenly incremented within the
range of zeros .
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Interpolating in a Series

∎ Geometric fill : Adds new values to a series,
increasing each new value geometrically .

∎ Arithmetic fill : Adds new values to a series,
increasing each new value by a fixed amount .

If you want the program to fill in your series with
interpolated values later, simply enter zeros where you
want the program to interpolate new values . The
program will generate replacement values that will be
evenly incremented between the values that begin and
end the range of zeros . This process is illustrated in
Figure 3-10 .

Figure 3-10 . Interpolation effects within two series . (1) The
interpolation begins with the first zero value and ends (2) with the
last zero value. New numbers are generated to replace the zeros .
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To interpolate
between values
in a series

Keep in mind that :

• If the series of zeros begins or ends the series, the
interpolation will increment between the non-zero
value and zero ; the zero value at the start or end of
the range is left unchanged .

•

	

If the two values bordering the zeros are the same
number, all of the interpolated values will have
that value .

This procedure begins in the Edit display. (Select "Edit"
from the main menu to enter the Edit display.)

1. Select "series"

2. Select the series you want to interpolate .

3. Select "done."
The series is shown in the Edit display .

4. Select "fill ."

5. Select "interpolate ."
The program asks you to select the location to
replace with interpolated values.

6. Select any zero in the range .
The interpolated values replace the range of zeros
you have indicated .

If you decide that you have made a mistake and did not
really want to interpolate, or decide that you
interpolated in the wrong series or place in a series,
you can undo your error. See "Undoing Changes Made
to a Series" later in this chapter .

When you have finished interpolation you can execute
other editing commands in the Edit display, save the
series in the File display, or plot a graph based the
series in the Graph display .

Adding Numbers to a Series Geometrically

Adding numbers to a series geometrically generates
new entries based on three numbers that you select .
The first number is the number of new values you want
to generate. The second number is called the start value;
it is the number your new values will start with . The
last number is called the factor; it is multiplied against
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the start value, creating a new start value each time .
This process continues, the factor being multiplied
against the start value, until the number of new entries
you indicated has been generated . This process is
illustrated in Figure 3-11 .

Keep in mind that :

•

	

If the start value selected for the fill has entries
following it, those entries will be moved to make
room for the new filled values .

• You can fill an empty series geometrically . Select the
word "empty" under the series name . The program
will ask you to enter a start value . The rest of the fill
will proceed as described below.

•

	

You can fill before the first value in a series . Select
the first number in the series, and the program will
ask you for a start value . The rest of the fill will
proceed as described below. The existing numbers in
the series will be moved down to make room for the
new numbers.

This procedure begins in the Edit display. (Select "Edit"
from the main menu to enter the Edit display.)

To fill a series

	

1. Select "series ."
geometrically 2 . Select the series you want to fill .

3. Select "done ."
The series is shown in the Edit display.

4. Select "fill ."

Figure 3-11 . Filling a series geometrically. Three new values are
needed in the series, so the factor for the fill is entered as 3 . (1) The
start value already exists in Series A . The factor, 3, is multiplied
against the start value (2) and generates a new start value (3) . The
new start value of 9 is again multiplied against the factor and a new
start value is generated . (4) This process continues until the total
number of new filled values has been generated (5) .
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5. Select "geometric-fill :"
The program asks you to select the location you
want to fill .
Remember that the start value will be the number
before this selected location . If you select the first
blank row under a series, the last number in the
series will be used as the start value .

6. Select the location where you want to begin the
geometric fill .
The program asks you for the number of new values
you want to generate .

7. Type the number of new values and press (ENTER) .
If the series you are filling is empty, or if you are
filling before the first number in the series, the
program asks for a start value. This start value will
be the first new value in the series .

8. Enter the start value you want to use for the
geometric fill and press ( ENTER).
The program asks you to enter the factor for the
geometric fill .

9. Type the factor for the fill and press (ENTER)
The filled values are entered into the series .

If you decide that you have made a mistake and did not
really want to fill after all, or decide that you filled in
the wrong series or place in a series, you can undo your
error. See "Undoing Changes Made to a Series" later in
this chapter.

When you have finished filling your series, you can
execute other editing commands in the Edit display,
save the series in the Files display, or plot a graph with
the series in the Graph display.

Adding Numbers to a Series Arithmetically
Adding numbers to a series arithmetically lets you
generate new entries that are based on three numbers .
The first number is the number of new values you want
to generate. The second number is called the start value
and is the value your new numbers will start with . The
last number is called the increment; it is added to the



To fill a series

	

1. Select "series ."
arithmetically
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start value, creating a new start value . This process
continues, the increment being added to the start value,
until the number of new entries you indicated has been
generated . This process is illustrated in Figure 3-12 .

Keep in mind that :

•

	

If the start value selected for the fill has entries
following it, those entries will be moved down to
make room for the new filled values .

•

	

If the series is empty of numbers, you can still fill it
arithmetically. Select the "empty" symbol under the
series name . The program will ask you to enter a
start value . The rest of the fill will proceed as
described below .

•

	

You can fill before the first value in a series . Select
the first number in the series, and the program will
ask you for a start value . The rest of the fill will
proceed as described below. The existing numbers in
the series will be moved down to make room for the
new numbers .

This procedure begins in the Edit display . (Select "Edit"
from the main menu to enter the Edit display.)

2 . Select the series you want to fill .

3. Select "done ."
The series appears in the Edit display .

4. Select "fill."

Figure 3-12 . Filling a series arithmetically : Three new values are
needed in the series, so the increment for the fill is entered as 3 . (1)
The start value already exists in Series A . The increment, 3, is
added to the start value (2) and generates a new start value (3) . The
new start value of 6 is again added to the increment and a new start
value is generated (4) . This process continues until the total number
of new filled values has been generated (5) .
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5. Select "arithmetic-fill ."
The program asks you to select the location you
want to fill .
Remember that the start value will be the number
before this selected location . If you select the first
blank row under a series, the last number in the
series will be used as the start value .

6. Select the location where you want to begin the
arithmetic fill .
The program asks you for the number of new values
you want to generate .

7. Type the number of new values and press (ENTER)
If the series you are filling is empty, or if you are
filling before the first number in the series, the
program asks for a start value . This start value will
be the first new value in the series .
∎ Enter the start value you want to use for the

arithmetic fill and press (ENTER).
The program asks you to enter the increment for the
arithmetic fill .

8. Type the increment for the fill and press (ENTER).
The filled values are entered into the series .

If you decide that you have made a mistake and did not
really want to fill after all, or decide that you filled in
the wrong series or place in a series, you can undo your
error. See "Undoing Changes Made to a Series" later in
this chapter.

When you have finished filling your series, you can
execute other editing commands in the Edit display,
save the series in the Files display, or plot a graph with
the series in the Graph display.

Changing the Way Numbers Are Displayed
Occasionally, because you are working with many
series or working in a small window, you will want to
change the precision (number of decimal places) to
which your numbers are displayed .
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Changing the precision of your numbers can be done at
any time while you are in the Edit display. You must
open the Edit options sheet to change the displayed
precision of your numbers . For additional information
on options sheets, see "How Do You Use the Visi On
Graph Program?" in Chapter 1 .

Figure 3-13 illustrates the three different types of display
formats available in the Edit display.

You can change the display options as many times as
you like while you are editing . Changing display
options only changes the way your numbers are
displayed, not their actual value .

Figure 3-13. Numbers can be displayed in three different ways .
The number 4.83213 is in floating point (the current options sheet
selection), so as many decimal places as can fit will be shown in the
Edit display. It could also be displayed in dollar format, which forces
two decimal places, or fixed point, which displays the number of
decimal places (up to 6) that you enter.
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To change the
Edit display
format

You should be in the Edit display. If the options sheet is
already open for this display, you may begin with
step 3 .

1. Select "OPTIONS" from the Visi On menu line .
The program asks you to select the window in which
you want to change options.

2. Select the Visi On Graph window .
The Edit options sheet appears to the right of the
Edit display.

3. Scroll the "Data Display Format" options into view
and select either :

"floating point" shows as many decimal places as
can fit .

∎ "dollars" shows values to two decimal places
∎ "fixed point" shows value to the number of

decimal places shown in the highlighted number
to the right .

To change the

	

1. Select the highlighted number to the right of the
fixed-point value

	

"fixed point" selection .

2 . Press (E N D) . Type the number of decimal places
(between 0 and 6) you want to display, and press

(ENTER). The display format option automatically
changes to "fixed point ."
You can leave the Edit options sheet open while you
edit your series or close it as is done in this last step .
These last steps are optional .

3. Select "done" from the options menu .
The Edit options sheet disappears from the Edit
display.

You can now continue editing your series, changing the
display options as often as you wish .

Undoing Changes Made to a Series
Everybody makes mistakes, but in the Visi On Graph
program they are easily corrected . While you are in the
Edit display, you are working with a copy of your
previously stored series . Because you work with a
series that you have previously saved, you can only
damage the copy, not the saved series .



In addition, you have a second level of protection in the
Visi On Graph program : the "undo" command . If, for
any reason, you feel that the changes you have made to
a series should not have been made, the "undo"
command will restore your series to the state they were
in before you began to edit them .

However, if you leave the Edit display and go to the
Graph display or any other section of the program, the
changes you have made to your series will be made to
the copies of your series in the working folder. If you
then realize that you need the series back in their
original, pre-edited state, you must reload them in the
Files display. For additional information on loading and
saving, see Chapter 2, "Saving, Getting, and
Organizing Series and Graphs ."

Remember : For the "undo" command to have any effect
on your series, you must select it before you exit the
Edit display.

To undo change ;
made to a series
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1 . Select "undo" from the Edit menu .
The program asks you to confirm that you really
want to undo the current editing session .

2 . Select :
∎ "Yes" if you want to undo the current editing

session .
∎ "No" if you do not want to undo the current

editing session .

Depending upon your confirmation, the session is
either undone (returned to their original state) or left as
you changed them. You can continue editing the
current series, select new series to edit, or continue
with any other Visi On Graph function .

Clearing Series from the Edit Display
Occasionally, you will want to remove a series from the
Edit display, either to make room for other series, or so
that you can edit a series with a different periodicity.
The "clear" command makes this procedure quite
simple .

Clearing a series from the Edit display does not remove
it from the working folder, it merely erases it from the
Edit display. When you use the "clear" command
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you have the option of saving the series you have
edited in the working folder or not .

To clear series

	

1. Select "clear" from the Edit menu .
from the Edit

	

The program asks you to select each of the series
display

	

you want to clear from the Edit display.

2 . Select the series columns you want to clear from the
display.
You may select any of the columns . As you select
them, the series are highlighted, indicating that they
have been selected. If you select one by mistake,
selecting it again removes the highlight, indicating
that it is no longer selected .

3. When you have finished selecting series, select
"done."
The program asks you if you want to save the series
you are clearing in the working folder .

4. Select :
∎ "yes" if you want to replace the working folder

copies of the series you are clearing from the Edit
display with the newly edited versions .

∎ "no" if you do not want to keep the changes you
have made to these series .

∎ "STOP" from the Visi On menu line if you have
decided not to clear these series from the Edit
display.

Depending upon your confirmation, the changes you
have made to these series are either saved in the
working folder or discarded . The highlighted series are
cleared from the Edit display. You can select new series
to display, continue editing the current series (if any),
or continue with any other Visi On Graph function .
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Making Graphs from Your Information
No matter how you entered your numbers into the
program-whether directly through the Visi On Graph'
Edit display, from another program with the Visi On
"TRANSFER" command, or by some other method-
the end result is a graph based on your numbers . This
chapter discusses all the steps required to create each of
the basic graph types .

With the Visi On Graph program, you can create
several versatile types of graphs . With stacked bar graphs
or comparative bar graphs you can show information
either cumulatively or side by side for comparison . You
can create line graphs to graphically track measurements
and compare the results of up to 12 sequences of
measurements . Area graphs track measurements in the
same manner that line graphs do, but fill the area
below the line with a pattern . X-Y graphs allow you to
plot the intersections of two different sequences, using
a variety of symbols . Pie graphs can illustrate the
contribution of the many parts of a cumulative whole .
Finally, high-low and high-low-close graphs, although
commonly used for presenting stock price histories,
have many other applications as well .

This chapter gives you step-by-step procedures for
creating each of these types of graphs .

After you become familiar with the steps used to make
the basic graphs, you may want to emphasize certain
aspects of your information. Chapter 5, "Enhancing
Your Graph," will tell you how to add detail where you
need it .

The steps used in making each type of graph follow the
same general pattern :

1. Your series must be in the working folder.
Series are loaded into the working folder by either:
LL Copying a stored series from the current folder

(see Chapter 2, "Saving, Getting, and Organizing
Series and Graphs") .
Entering series in the Edit display (see Chapter 3,
"Creating Series") .
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∎

	

Transferring series from another program (see
Chapter 7, "Transferring Information') .

2. Select the series you are plotting .

3. Select a graph type :
∎

	

Line
∎

	

Bar
∎

	

Pie
∎	X-Y
∎

	

Area
∎ High-low-close

4. Some graph types require additional information,
such as a specific time period . These are discussed
in more detail in the following sections .

5. Select "plot" to draw the graph .

Whenever you draw a new graph, the program
remembers the options you chose last and uses them in
the new graph . However, you can change any or all of
these options before drawing the new graph .

Say, for instance, that you have selected a line graph for
your series . After drawing the line graph, you might
wonder what the same series would look like in a bar
graph . To see it, simply erase the current graph, select
the bar graph type, and redraw. You do not have to
reselect the series ; your previous selections will be
used. Likewise, if you want to see another series in the
same type of graph that you just plotted, erase the
graph, select that series name, and redraw the graph .
The last graph type you selected is used with the
new series .

Plotting Line, Area, and Bar Graphs
Although you can use the same general steps to create
them, bar, area, and line graphs have distinctly
different appearances and are generally used for
different applications :

∎ Line graphs are commonly used to keep track of
single-point information, such as physical
measurements, temperatures, and percentages .



To select the
series for a line,
area, or single-
series bar graph

To select a
specific graph
type
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∎ Bar and area graphs are commonly used to keep
track of cumulative or volume information, such as
sales, inventory, and population .

The procedures used to plot line, area, and bar graphs
are very similar. Multiple-series bar graphs are
explained in the following section, "Plotting Bar
Graphs with More Than One Series ."

Make sure that your series is in your working folder .
You must have copied it from the current folder,
transferred the series data from another product, or
have entered it directly in the Edit display .

This procedure begins in the Graph main menu .

1 . Select "data" from the Graph main menu .

2. Select "series" from the data types menu .
The names of the available series are displayed .

3. Select the name of each series you want to use in the
current graph .
If you are plotting line or area graphs you may select
up to 12 series for each graph . (Plotting multiple-
series bar graphs is discussed in the following
section .)

4. When you have finished selecting series, select
"done ."
If you selected 12 series names in step 3, you will not
need to select "done." You are automatically returned
to the Graph main menu .
You are returned to the Graph main menu .

At this point you could select "plot" from the Graph
main menu and a graph would be drawn . This graph
would use the same selections and options that you set
up for your last graph .

1. Select "style ."

2 . Select your graph type .
Select either "Line;' "Bar," or "Area ." (Pie, X-Y, and
high-low-close graphs are discussed later in this
chapter.)
∎ If you selected "Area,' as in Figure 4-1, you are

returned to the Graph main menu .
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Figure 4-1 . 'Area"
connects each of the
series points to the
next with a straight
line and fills the area
below the line with a
pattern .

Figure 4-2 . "Line"
connects each of the
series points to the
next with a straight
line.

If you selected "Line' or "Bar," you will have to
make one additional selection :

∎ If you selected "Line," select the type symbol you
want to use. Select either :
- "Line" (See Figure 4-2) .



Figure 4-3 . "Symbol"
identifies each of the
series points with a
graphic character
(+, * etc.) When
more than one series is
used in a line graph,
different symbols are
assigned to each series .

Figure 4-4 . Selecting
"Both" identifies each
series with its own
symbol and connects
the points with
straight lines .

"Symbol" (See Figure 4-3) .

- "Both" (See Figure 4-4) .

Making Graphs from Your Information 4-5
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Figure 4-5. Selecting
"Point" places a single
dot on the graph for
each series point .

- "Point" (See Figure 4-5) .

After you select the symbol type you want to use, you
are returned to the Graph main menu.

Both stacked and comparative bar graphs are discussed
in detail later in this chapter .

For a single-series bar graph :
Select "Stack" or "Compare ."
You may choose either. It does not make any
difference in a single-series bar graph .
After you select the graph type, you return to the
Graph main menu .

After you have selected your series and graph type, you
are ready to draw the graph :

To draw the

	

1. Select "erase" from the Graph main menu to clear
selected graph

	

the display of any previous graph .

2 . Select "plot ."
The horizontal and vertical axes are drawn first,
followed by the lines, bars, or areas representing
your selected series .



Figure 4-6 . A simple
bar graph uses
rectangles to represent
the size of each value
in the series .

Making Graphs from Your Information 4-7

When you see the graph you have created, you may
realize that something needs to be changed, either in
the series values themselves, or regarding the options
you have selected to draw the graph .

To change some of the information in your series and
replot it, simply return to the Edit menu, where the
series used in the current graph are automatically
shown, and edit the series. When you return to the
Graph main menu, the graph is automatically redrawn
with the new information, using your previous options
and selections . You can replot the same series any
number of times, trying different graph types or
different options within the same graph type .

Plotting Bar Graphs with More Than One Series
This section describes the differences between stacked
bar graphs and comparative bar graphs . Instructions for
creating stacked bar graphs and comparative bar graphs
are in the next section .

Stacked Bar and Comparative Bar Graphs
Although stacked bar graphs and comparative bar
graphs are created with similar procedures, they
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present your series in two different ways :

∎ Stacked bar graphs stack the information for each
period of each series, showing cumulative period
totals .
Stacked bar graphs are commonly used to keep track
of cumulative or volume information, such as sales,
inventory, and population . Stacking the bars
displays the cumulative total of each of the
individual series .

∎ Comparative bar graphs place information from
different series (but with the same periods) next to
each other, showing the differences between each
series .
Comparative bar graphs are also used to keep track
of several series of cumulative or volume
information, such as sales, inventory, and
population. Because the bars are drawn next to each
other, you can easily compare the series .

In both types of graphs, the series used must have the
same periodicity but may have different beginnings,
endings, and number of periods . Both graph types
require more than one series . You can have a maximum
of 12 series in any graph .

(Periodicity and specifying periodicity for a series are
explained in "Understanding Series" in Chapter 3 .)

Figure 4-7 shows three separate series : Mktg ., Corp.,
and Dist. These series were used to create the stacked
bar graph in Figure 4-8 and the comparative bar graph
in Figure 4-9 .

Figure 4-7. The Mktg., Corp., and Dist. series, which were used to
create the graph in Figure 4-8 .



Figure 4-8. When
you use a stacked bar
graph, your picture
shows the effect of the
combined series
values. Each is
identified by series but
contributes to the total
height .

Figure 4-9. When
you use a comparative
bar graph, your
picture shows the
difference between
series values of the
same period. Points of
the same period from
each series are drawn
next to each other,
providing an easily
interpreted
comparative picture.

Series used in bar graphs are drawn in the order that
they are selected . In this example, Mktg . is selected
first, Corp. second, and Dist. last . The stacked bar
graph type is selected and then drawn as in Figure 4-8 .
Notice that Mktg . values are drawn first and that Corp .
and Dist . are drawn above Mktg .

Making Graphs from Your Information 4-9



4-10 Turning Series into Graphs

Plotting Stacked Bar Graphs

Figure 4-10 . Stacked
bar graphs are
commonly used to keep
track of cumulative or
volume information,
such as sales,
inventory, and
population . Stacking
the bars displays
cumulative total of
each of the individual
series .

Selection order is also important in comparative bar
graphs . In this example the order is the same : Mktg .
first, Corp. second, and Dist . last . The comparative bar
graph type is selected and then drawn as in Figure 4-9.
Notice that Mktg . values are drawn first and that Corp .
and Dist . are drawn to the right of Mktg .

Negative values can affect a stacked bar graph in
two ways :

•

	

If a series has negative values, the Y-axis of its graph
will be scaled to contain negative values in the range .

•

	

When positive and negative values are stacked on
the same period, the negative value will lower the
top of the bar, rather than be stacked above a
positive value .

Because series are drawn in the order they are selected,
the first series selected will occupy the lower regions of
a stacked bar graph and the later series will be
drawn higher.

Before you begin, make sure that your series are in your
working folder. You must have copied them from the
current folder, transferred them from another program,
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or have entered them in the Edit display. You must have
at least two series in your working folder for a stacked
bar graph .

This procedure begins in the Graph main menu .

To plot a stacked 1. Select "erase" from the Graph main menu to clear
bar graph

	

the display of any previous graph .

2 . Select "data' from the Graph main menu .

3. Select "series" from the data types menu .
The series available for plotting are shown above the
menu .

4. Select each series (up to 12) you wish to plot .
Remember: Series are drawn in the order they are
selected. The first series is plotted lowest and the
later series are plotted higher.

5. Select "done."
If you selected 12 series names in step 4, you will not
need to select "done." You are automatically returned
to the Graph main menu .

6. Select "style" from the Graph main menu .

7. Select "bar" from the graph type menu .

8. Select "stack" from the bar type menu .
You are now back at the Graph main menu, ready to
plot your graph .

9. Select "plot."

The horizontal and vertical axes are drawn first,
followed by the stacked bars .

When you see the graph you have created, you may
realize that something needs to be changed, either in
the series values themselves or regarding the options
you have selected to draw the graph .

To change some of the information in your series and
replot it, simply return to the Edit menu, where the
series used in the current graph are automatically
shown, and edit the series . When you return to the
Graph main menu, the graph is automatically redrawn
with the new information, using your previous options
and selections. You can replot the same series any
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Before you begin, make sure that your series are in your
working folder. You must have copied them from the
current folder, transferred them from another program,
or have entered them directly in the Edit display. You
must have at least two series in your working folder for
a comparative bar graph .

This procedure begins in the Graph main menu .

To plot a

	

1. Select "erase" from the Graph main menu to clear
comparative bar

	

the display of any previous graph .
graph 2 . Select "data' from the Graph main menu .

number of times, trying different graph types or
different options within the same graph type .

Plotting Comparative (Side-by-Side) Bar Graphs

3. Select "series" from the data types menu .
The series available for plotting are shown above the
menu .

Figure 4-11 . Comparative bar graphs are commonly used to keep
track of several series of cumulative or volume information, such as
sales, inventory, and population . Because the bars are drawn next to
each other, you can easily compare the series .
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4. Select up to 12 series .
Remember : The series are plotted in the order they
are selected; the first series is drawn leftmost and
the later series are drawn to the right .

5. Select "done."
If you selected 12 series names in step 3, you will not
need to select "done." You are automatically returned
to the Graph main menu .

6. Select "style" from the Graph main menu .

7. Select "bar" from the graph type menu .

8. Select "compare" from the bar type menu .
You are now back at the Graph main menu, ready to
plot your graph .

9. Select "plot ."

The horizontal and vertical axes are drawn first,
followed by the comparative bars .

When you see the graph you have created, you may
realize that something needs to be changed, either in
the series values themselves or regarding the options
you have selected to draw the graph .

To change some of the information in your series and
replot it, simply return to the Edit menu and edit the
series. When you return to the Graph main menu, the
graph is redrawn with the new information, using the
options and selections from the previous graph . You
can redraw the same series any number of times, trying
different graph types or different options within the
same graph type .

Plotting High-Low-Close Graphs
A high-low graph plots the high and low points from
two series and connects them with a vertical line .

A high-low-close graph adds a value from a third series
(the close) and marks this point on each of the vertical
high-low lines. (The values in a close series should fall
between the high and low series for each period on the
X axis.)
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Figure 4-13. A
high-low-close graph
requires three series,
one composed of the
high values for each
time point, a second
for the matching low
values for the same
time points, and a
third that shows the
final position at the
end of the time period .
This type of graph is
commonly used in
recording and
presenting stock price
histories, on a daily or
weekly basis .

The high-low graph uses two series and the
high-low-close graph uses three series .

Figures 4-12 and 4-13 show examples of high-low and
high-low-close graphs .

Figure 4-12 . A
high-low graph plots
the high and low
points from two series .
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When selecting the series to plot in a high-low-close
graph, either the high or low series can be selected
first, but the close series must be selected last .

Before you begin, make sure that your series are in your
working folder. You must have copied them from the
current folder, transferred them from another program,
or have entered them directly in the Edit display . You
must have at least two series in your working folder for
a high-low graph and three series for a high-low-close
graph . All of the series must have the same periodicity .

This procedure begins in the Graph main menu .

To plot a high-

	

1. Select "erase" from the Graph main menu to clear
low or high-low-

	

the display of any previous graph .
close graph

	

2. Select "data" from the Graph main menu .

3. Select "series" from the data types menu .
The series available for plotting are shown above the
menu .

4. Select each of the series names you wish to plot .
You may select the high and low series in any order
you wish . If you are plotting a high-low-close graph,
select the close series last .

5. When you have finished selecting series, select
"done:"
You are returned to the Graph main menu .

6. Select "style" from the Graph main menu .

7. Select "Hi-Lo-CI" from the graph type menu .
You are now back at the Graph main menu, ready to
plot your graph .

8. Select "plot ."

The horizontal and vertical axes are drawn first,
followed by the high-low lines . If you selected a close
series, the marks representing these values are drawn
last .

When you see the graph you have created, you may
realize that something needs to be changed, either in
the series values themselves or regarding the options
you have selected to draw the graph .

To change some of the information in your series and
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replot it, simply return to the Edit menu, where the
series used in the current graph are automatically
shown, and edit the series. When you return to the
Graph main menu, the graph is automatically redrawn
with the new information, using your previous options
and selections. You can replot the same series any
number of times, trying different graph types or
different options within the same graph type .
Note : Do not add vertical grid lines to a high-low or
high-low-close graph . The vertical grids will be drawn
over the high-low lines and make them hard to
interpret .

Plotting X-Y Graphs

An X-Y graph plots the intersections of the points of
two series . Two series with the same periodicity are
required to plot an X-Y graph . The first series selected
provides the X values and the second provides the Y
values . If either series contains more values than the
other, those values are not plotted .
X-Y graphs can be plotted with four different
combinations of symbols : line, symbols, points, or both
(lines and symbols) . Examples of these four types of X-Y
graphs are shown in Figures 4-14, 4-15, 4-16, and 4-17.
Before you begin, make sure that your series are in your
working folder. You must have copied them from the
current folder, transferred them from another program,
or have entered them directly in the Edit display . You
must have at least two series in your working folder for
an X-Y graph .
This procedure begins in the Graph main menu .

To plot an X-Y

	

1. Select "erase" from the Graph main menu to clear
graph

	

the display of any previous graph .

2 . Select "data' from the Graph main menu .

3. Select "series" from the data types menu .
The series available for plotting are shown above the
menu .

4. Select the names of the two series you wish to plot .
The available series are shown above the menu . The
first series you select is used as the X series and the
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Figure 4-14 . An X-Y graph shows the correlation between series
points. This type of graph is commonly used to express the
relationship between series, such as rainfall and crop growth,
advertising expenditures and sales, etc . This graph uses the "lines"
option .

Figure 4-15. This graph presents the same series as Figure 4-14
above, but uses the "symbol" option .
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Figure 4-16. This graph presents the same series as Figure 4-14
above, but uses the "point" option .

Figure 4-17. This graph presents the same series as Figure 4-14
above, but uses the "both" (lines and symbols) option .



5. Select "done ."

7. Select "X-Y" from the graph type menu .

8. Select the X-Y symbol type .

You can plot X-Y graphs in four different ways : with
lines, symbols, points, or both (lines and symbols) .
Each of these options is described below .
∎ "line" connects each calculated point to the next

point with a straight line .
( "symbol" identifies each of the calculated points

with a character (+, ' #, etc . )
"point" places a single dot on the graph for each
calculated point .

L "both" identifies each calculated point with its
own symbol and connects the points with straight
lines in the order in which they occur in the
series .

After you select the symbol type, you return to the
Graph main menu, ready to plot your graph .

Plotting X-Y Graphs 4-19

second becomes the Y series . These series must have
the same periodicity .

6. Select "style" from the Graph main menu .

9. Select "plot ."
The horizontal and vertical axes are drawn first,
followed by the points where your X and Y series
intersect .

When you see the graph you have created, you may
realize that something needs to be changed, either in
the series values themselves or regarding the options
you have selected to draw the graph .

To change some of the information in your series and
replot it, simply return to the Edit menu, where the
series used in the current graph are automatically
shown, and edit the series . When you return to the
Graph main menu, the graph is automatically redrawn
with the new information, using your previous options
and selections . You can replot the same series any
number of times, trying different graph types or
different options within the same graph type .
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Plotting Pie Graphs
A pie graph uses one or more series to create an image
of each period or series contribution (slice) to the whole
pie. Each period or series becomes a slice of the total,
as a percentage of the total period's value, as is seen in
Figure 4-19 .

Before you begin, make sure that your series are in the
working folder. You must have copied them from the
current folder, transferred them from another program,
or have entered them directly in the edit display.

This procedure begins in the Graph main menu .

To plot a pie

	

1. Select "erase" from the Graph main menu to clear
graph

	

the display of any previous graph .

2. Select "data' from the Graph main menu.

3. Select "series" from the data types menu .
The available series names are shown above the
menu.

Figure 4-18. Pie graphs show the contribution to the whole pie of
each period displayed in the graph . This type of graph is commonly
used where it is necessary to display each series point's contribution
to the whole picture .



4. Select up to 12 of the series names .
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Figure 4-19 . A pie graph can be developed from all the periods in one series, or from
matching periods in several series .

5. Select "done."
If you selected 12 series names in step 4, you will not
need to select "done ." You are automatically returned
to the Graph main menu .
You are returned to the Graph main menu .

6. Select "style" from the Graph main menu .

7. Select "pie" from the graph type menu .

8 . Select "plot ."
The program asks you for a beginning year .
This question may not make sense to you if your
series does not take years into account; that is, if
your series periodicity is 7 (weekly) or 1 (daily), and
so forth . In this case, you should enter the first
major period (year) that contains information you
want to use in the pie graph . This is illustrated in
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9.

Figure 4-20. (Note : If you are plotting a pie graph
with more than one series, the beginning year and
beginning period indicate the one period that will
be extracted from each of the series and used as a
slice of the whole pie . An end year and period are
not used.)

The program will always ask for the beginning year .
However, if your series uses a periodicity of 1, the
program will not prompt for a beginning period or
ending period . After you enter the beginning year,
the program will ask for the ending year . When
your series use a periodicity of 1, there is no minor
period . (For additional information on series and
series periodicities, see Chapter 3, "Creating
Series .")

Figure 4-20 . This series uses a periodicity of 7 (weekly) . The values
that are going to be used in the graph are 23 .4, 4.0, 8.6, 13.6, 12 .4,
and 15.2 . When the program asks for the start year, this user replies
with 3, the major period, or week, that contains the first value used
in the graph . The start period is 3, for the matching first value .
When the program asks for the end year and end period, they are
entered as 4 and 1, respectively. (Note: 1f you are plotting a pie
graph with more than one series, the beginning year and beginning
period indicate the one period that will be extracted from each of the
series and used as a slice of the whole pie .)

Type the beginning year you want to plot in the
graph . Enter the value by typing (ENTER) .
The program asks for the beginning period . (If your
series periodicity is one, this prompt will not occur
and you can skip this step .)
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10. Type the beginning period value you want to plot
in the graph. Enter the value by pressing (ENTER)
∎ If you selected more than one series, entering

the beginning period to plot will draw the
graph . This completes your pie graph, and you
can skip the additional numbered instructions in
this section .

∎ If you have selected only one series, the
program asks you for an ending year .

The program asks for the ending year .

11. Type the ending year you want to plot in the graph .
Enter the value by pressing (ENTER).
The program asks for the ending period . (If your
series periodicity is 1, this prompt will not occur
and you should skip step 12 .)

12. Type the ending period value you want to plot in
the graph . Enter the value by pressing ( ENTER).
When you enter the last value, the pie graph is
drawn in the Graph display.

When you see the graph you have created, you may
realize that something needs to be changed, either in
the series values themselves or regarding the options
you have selected to draw the graph .

To change some of the information in your series and
replot it, simply return to the Edit menu, where the
series used in the current graph are automatically
shown, and edit the series. When you return to the
Graph main menu, the graph is automatically redrawn
with the new information, using your previous options
and selections . You can replot the same series any
number of times, trying different graph types or
different options within the same graph type .

Erasing the Graph Display
With the "erase" command of the Graph main menu
you can clear the Graph display of any previously
plotted series, labels, text, and format options (such as
grids or background) . You can redraw your last graph
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This procedure begins in the Graph main menu .

1 . Select "erase" from the Graph main menu .

after you select "erase" by selecting "plot ." However,
you will have to reenter any labeling, scaling, or text
that was on the erased graph . Only the basic graph will
be redrawn .

When you select a new graph type or series, the "plot"
command does not erase the previous graph before it
draws the new graph . If you do not erase before
selecting "plot;" the new graph may be drawn over the
current graph. This is called an overlay and is
sometimes desirable . For information on creating
overlay graphs, see "Overlaying Graphs" in Chapter 5 .

To erase the
Graph display
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Labeling Your Graph

Labeling Your Graph 5-1

With the Visi On Graph" program, you can create
special effects in your graphs to highlight important
areas or place additional information in the display .

With the techniques described in this chapter, you can :

•

	

Create labels for a main title, a subtitle, a bottom
title, or a side title .

•

	

Add text to your graphs to explain a point .

•

	

Add a legend to identify the series used in the
graph .

•

	

Select two different font types for any label or text :
roman or bold .

•

	

Add or remove tick marks on your X and Y axes for
clarity.

•

	

Control shading used in bar, area, and pie graphs .

•

	

Change the background color .

•

	

Overlay graphs with other graphs .

•

	

Change the scale of a graph .

This chapter contains step-by-step instructions for all of
these enhancement techniques .

One picture is worth a thousand words, but in a graph,
a few carefully chosen words can double the value of
your picture. Labels can call out points of interest,
explain seeming discrepancies, and provide information
that is not graphically represented .

A title is a group of words on a graph, used to clarify or
explain the contents of the graph. Titles are always
entered in a fixed position .

•

	

Main title labels are horizontal, at the top of a graph .

•

	

Subtitle titles are on a line just below and parallel to
main titles .

•

	

The bottom title runs below the graph's X axis .

•

	

The side title runs to the left of, and parallel to, the Y
axis .
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Figure 5-1. Labels can be used in many ways : to define or enhance
a graph, or to call attention to or explain any area on the graph .

Text is another type of label . Text can be positioned
anywhere on the graph, can be one or more lines, and
can run vertically or horizontally.

The legend is a group of labels the program adds to
identify the different series that are used in the graph.
Legends are treated differently from the other labels .
They are discussed in "Adding or Removing a Legend"
later in this chapter .

You should keep the following considerations in mind
when you work with labels :

Text should be one of the last things you place on
your graph. If you are still adding series to the
graph, text might obscure, or be obscured by, the
newly plotted graph .

The "erase" command clears your graph and its
labels from the display. The "plot" and "rescale"
commands redraw the graph and retain the labels
from the previous graph .

Because the graph displayed in your window may
not have exactly the same proportions as the graph
you print, labels may be printed in a different
position than the one displayed in the window. The
"partition' and "size" options of the Print and
Graph options sheets can show you how your graph
will print (see Chapter 6, "Printing" and "How Do
You Use the Visi On Graph Program?" in Chapter 1) .



Adding a Title

∎ Main, sub-, and bottom titles, which are horizontal,
are centered horizontally on the graph .

•

	

Side labels, which are vertical labels, are centered
vertically on the graph .

With the "title" command you can place a main title,
subtitle, side title, or bottom title on your graph . The
procedure is the same for all types of graphs .

Each type of title is placed in a specific area of the
graph :

•

	

"Main" titles appear at the top of the graph.

• "Subtitle" titles are printed on the second line from
the top of the graph . You do not have to have a main
title to have a subtitle .

•

	

"Bottom" titles are printed below the horizontal
or X axis .

•

	

"Side" titles are printed parallel to the vertical
or Y axis .

To put a title on

	

1. Select "Annotate" from the Graph menu .
your graph 2 . Select "title ."

3. Select your type of title :
∎

	

"Main"
∎ "Subtitle"
∎

	

"Side"
∎ "Bottom"

4. Enter your title .

5. Press (ENTER)
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How much text can be shown in the Graph or Annotate
display depends on your window size . You can place
more text on your graph than can be shown in the
window and it may still appear on the printed graph .
(See Chapter 6, "Printing". )
You can continue to add labels in the Annotate menu,
or if this completes your graph, choose to save your
current graph (see Chapter 2, "Saving, Getting, and
Organizing Series and Graphs") or print it (see
Chapter 6, "'Printing") .
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Adding Text to a Graph

Figure 5-2. Usually used to describe or identify your graphs, titles
are always entered to a fixed position on the graph .

With the "add" command, you can place a label or
block of text anywhere on your graph . The text can be
printed horizontally or vertically, as shown
in Figure 5-3.

To place text on

	

1. Select "Annotate" from the Graph menu .
your graph

	

2. Select "add ."

Figure 5-3. Text, either horizontal or vertical, can be put anywhere
on your graph .



Replacing Labels

3. Select the direction you wish your text to be
displayed :
∎ "Horizontal"
∎ "Vertical"

4. Select the location on the graph where you want to
start your text .
This selection establishes the lower left corner of the
first character in the first line of text and sets the
margin for additional lines of text .

5. Enter your text .
How much text can be displayed on your graph
depends on the size of your window . You can put
more text on the graph than can be shown in the
window but that text may appear on your printed
graph. (See Chapter 6, "Printing :')

6. Press (ENTER)) to place the text on the graph .

7. If you want to place more lines of text on the graph,
you may continue your entry. Each additional line of
horizontal text is placed below the previous line .
Each additional line of vertical text is placed to the
right of the previous line .

8. To stop entering text, press (ENTER) when the cursor is
on a blank entry line .

You can continue to add labels in the Annotate menu,
or if this completes your graph, choose to save your
current graph (see Chapter 2, "Saving, Getting, and
Organizing Series and Graphs") or print it
(see Chapter 6, "Printing") .
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You can replace a previously entered label or single text
line with the "replace" command . Any of the labels you
can place on a graph can be replaced . The legend title
and legend item labels can also be replaced . The new
label can be longer or shorter than the previous label . If
you select one line from a block of text, your new text
will replace that line only .
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Figure 5-4 . When the "replace" command is used to change the
contents of a label, the new label is entered in the same location as
the previous label .

To replace a label 1. Select "Annotate" from the Graph menu .
or text 2 . Select "replace ."

3. Select the label or text you want to replace .

4. Enter your new text just as if you were entering it the
first time .

5. Press (ENTER

How much text can be shown in the Graph display
depends on your window size . You can place more text
on your graph than can be shown in the window and it
may may still appear on the printed graph. (See
Chapter 6, "Printing".)

You can continue to add or replace labels in the
Annotate menu, or if this completes your graph,
choose to save your current graph (see Chapter 2,
"Saving, Getting, and Organizing Series and Graphs")
or print it (see Chapter 6, "Printing") .
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Figure 5-5. Any label can be moved . The label is erased from its
original position and redrawn wherever you want it .

You can move a previously entered label or block of text
to a new position on the graph with the "move"
command . Any of the labels you can place on a graph
can be moved . The legend title can be moved, but
legend item labels cannot be moved .

1 . Select "Annotate' from the Graph menu .

2. Select "move :"

3. Select the label or text you want to move .
The program asks you to select a new location for
the label .

4. Select the new location for the label .
This location is then used as the lower left corner of
the first character in the label . If the position you
select is too far to the right or too far down on the
graph, some of your label may be truncated . If this
happens, simply select a new location for the label .

To move a label
or block of text
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Using Fonts

The label is redrawn in the new location . The change
is not made permanent until you select "done' from
the menu line. You may continue to select new
locations for the label until you are satisfied with its
position . Each time you select a new location, the
old position is erased and the label is redrawn in the
new position .

5. Select "done" to fix the label in its new location .

The number of characters that you can show on one
line depends on where you begin the text . How much
text that can be shown in the Graph or Annotate
display depends on your window size . You can place
more text on your graph than can be shown in the
window and it may still appear on the printed graph .
(See Chapter 6, "Printing .")

You can continue to add labels in the Annotate menu,
or if this completes your graph, choose to save your
current graph (see Chapter 2, "Saving, Getting, and
Organizing Series and Graphs") or print it (see
Chapter 6, "Printing") .

You can change the appearance of the individual labels
you add to your graph by selecting different fonts . Each
font creates alphabetical, numeric, and punctuation
characters using different styles, letting you add
emphasis, draw attention to, or differentiate between
the different labels.

Figure 5-6 . Different typefaces (fonts) can be used with any label
you add to your graph . Once selected, a font is used with all labels
you add, until you select another font .



When you begin using the Visi On Graph program, the
font type is preset for "roman ." When you change the
font type, the new font type will be used for all of the
labels you add, until you select another.

To change the

	

1. Select "Annotate' from the Graph menu .
font type

Graph Options

2 . Select "font" from the Annotate menu .

3. Select your font type .
∎ Select "roman" for the standard typeface .

Select "boldface" for a thicker typeface .

You can switch fonts as many times as you like while
adding labels to a graph . It is a good idea when you are
first getting used to adding labels to change back to the
standard "roman" style font between creating graphs .

Removing Labels from a Graph
You can remove a label or block of text from a graph
with the "delete" command . Any of the labels or titles
you can place on a graph can be removed .

To remove a label 1. Select "Annotate" from the Graph menu .
or block of text 2 . Select "delete."

3. Select the label or text you want to remove .
The text is removed .

You are returned to the Annotate menu, where you can
remove more labels by repeating these steps, or
continue adding, replacing, and moving labels .

If this completes your graph, you may choose to save
it (see Chapter 2, "Saving, Getting, and Organizing
Series and Graphs") or print it (see Chapter 6,
"Printing") .
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The following sections discuss the changes that can be
made to your graphs with the Visi On Graph options
sheets .

For additional information on Visi On options sheets,
see the Visi On User's Guide.
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Automatic and Manual Options

To change the
redraw mode

Figure 5-7. The
"automatic" and
"manual" redraw
mode options control
when the current
graph is redrawn with
new options .

Two options that control when the screen is redrawn
appear at the beginning of the Print options sheet .
These options are "Redraw Mode automatic" and
"Redraw Mode manual" .

The preset selection is "automatic ." Every time you
select a new option in the Print options sheet, your
graph is redrawn with that new option active . If you are
changing several of your options at one time, you may
want to use the "manual" redraw mode .

1 . Select one of the following :
∎ "automatic" The graph will be redrawn every

time you select an option . You can also select
"automatic" to redraw the graph after changing
options in "manual" redraw mode.

∎ "manual" The graph will only be redrawn when
you select "plot" from the Visi On Graph menu
or select "automatic" from the redraw mode
options .

Adding or Removing a Legend
The legend lists each of the series used in the graph .
The identifying pattern or symbol that series uses in



To add or
remove a legend

Figure 5-8 . The
Legend option is near
the beginning of the
Graph options sheet
but, depending on
your window size, you
may have to scroll it
into view.

the graph appears next to the series name . The legend
is always drawn to the right of the graph ; it shows as
many of the series names as can fit in the window .
When you print your graph, however, the legend will
display every series used in it .

You may decide to remove the legend from your graph
and use the Visi On Graph labeling commands to
identify your individual series . Remember that
removing the legend increases the graph size and
amount of detail that you can display in your graph .

Legends are controlled by the Graph menu options
sheet . The preset option for legends is "yes" ; legends
will be displayed unless this option is changed to "no."

1. Select "OPTIONS" from the Visi On menu .

2 . Scroll the options sheet until the "Legend yes no"
option is visible, as in Figure 5-8.

3. Select one of the following :
∎ "yes" if you want to have a legend displayed or

printed with your graph .
∎ "no" if you do not want to have a legend

displayed or printed with your graph .

Graph Options 5-11
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Changing the Axis Labels

To change tick
mark labels on
either axis

If your options sheet redraw mode is set to "automatic,"
the graph will be redrawn immediately using the new
legend option.

If the redraw mode is set to "manual ;" you must redraw
the graph to see the effect of the new legend option .
See "Automatic and Manual Options" earlier in this
chapter for more information .

You can control the tick mark labels and the formats
they appear in on the horizontal and vertical axes of
your graphs .
Tick mark labels are the numbers along either axis that
show the value or period of the individual plotted
series points . You can change X-axis or Y-axis attributes
in the Graph options sheet to display them as dollars,
decimals, or in floating point .

You select labels for both the X and Y axes in the same
way. Follow the instructions below when changing
either set of attributes .

Changing tick marks on either axis
1. Select "OPTIONS" from the Visi On menu .

2 . Scroll the options sheet until the "X Axis attributes"
or "Y Axis attributes" option is visible, as in
Figure 5-9 .

3 . Select :
"major" if you want the graph's tick marks
labeled.

∎ "none' if you do not want the graph's tick marks
labeled.
The X-axis attributes allow a third choice : "major
and minor" labels . This option will affect your
graph only if your series have a periodicity of
greater than one . (See Chapter 3, "Creating
Series" for a complete description of series
periodicity.)

II "major and minor" if you want both major and
minor periods to be marked .

If your options sheet redraw mode is set to
"automatic;" the graph will be redrawn immediately



To select how the
tick mark values
are displayed

Figure 5-9 . The X- and Y-axis attributes options are near the end
of the Graph options sheet; you may need to scroll them into view.

using the new shading option .
If the redraw mode is set to "manual;" you must
redraw the graph to see the effect of the new option .
(See "Automatic and Manual Options" earlier in this
chapter for more information .)

Selecting dollars, decimals, or floating-point
format
1. Select "OPTIONS" from the Visi On menu .

Graph Options 5-13

2 . Scroll the options sheet until the "X Axis attributes"
or "Y Axis attributes" option is visible, as illustrated
in Figure 5-10 .

3 . Select one of the following :
∎ "floating point" if you want the label's

unformatted value to be displayed .
∎ "dollars" if you want the label's value to be

rounded to two decimal places .
∎ "fixed point" if you want to enter a number of

decimal places for the labels . You must then enter
the number of decimal places :



5-14 Enhancing Your Graphs

Figure 5-10. The
X- and Y-axis
attributes options are
near the end of the
Graph options sheet ;
you may need to scroll
it into view. The three
attribute options are
dollars, floating-point,
and fixed point .
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If you selected "fixed point" :

1. Select the white square to the right of the "fixed
point" option .

2 . Press (E N D) and then type the number of decimal
places you want (between one and three)
and press ( ENTER).

If your options sheet redraw mode is set to "automatic ;"
the graph will be redrawn immediately using
the new option .

If the redraw mode is set to "manual ;" you must redraw
the graph to see the effect of the new option . (See
"Automatic and Manual Options" earlier in this chapter
for more information .)
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You can draw bar, area, and pie graphs with or without
shading. If you do not change the Graph options sheet,
the preset value for this option is "yes" and shading
will be used .

Each series is drawn using a pattern that helps
distinguish it from the series next to it . If you change
the shading option to "no," the areas described in each
series will be outlined but not filled with a pattern .

To change the

	

1. Select "OPTIONS" from the Visi On menu .
shading option 2. Scroll the options sheet until the "Shading yes no"

option is visible, as illustrated in Figure 5-11 .

3. Select :
∎ "yes" if you want to use shading in the graph .
∎ "no" if you do not want to use shading in the

graph .

If your options sheet redraw mode is set to "automatic ;"
the graph will be redrawn immediately using the new
option.

If the redraw mode is set to "manual ;" you must redraw
the graph to see the effect of the new option. (See
"Automatic and Manual Options" earlier in this chapter
for more information .)
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Figure 5-11 . The shading option is near the beginning of the
Graph options sheet but, depending on your window size, you may
need to scroll it into view. This option controls whether or not your
bar, area, and pie graphs are filled with a pattern when they are
plotted .



Changing the Background Color

To change the
background
color option

You can choose either black or white for your
background color. When you select black, the Graph
display is black with white lines, patterns, and labels .
When you select white, the graph display is white with
black lines, patterns, and labels . Your background color
will be black unless you change this option .

This option affects the displayed graph . It has no effect
on the printed graph, which will always be printed
with a white background .

1 . Select "OPTIONS" from the Visi On menu .
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2. Scroll the options sheet until the "Screen
Background Black White" option is visible, as
illustrated in Figure 5-12 .

3. Select :
∎ "Black" if you want to use a black background in

your graph .
∎ "White" if you want to use a white background in

your graph .

If your options sheet redraw mode is set to "automatic ;"
the graph will be redrawn immediately using the new
screen background option .

If the redraw mode is set to "manual ;" you must redraw
the graph to see the effect of the new screen
background option . (See "Automatic and Manual
Options" earlier in this chapter for more information .)

Adding a Grid to Your Graph
You can add three types of grids to your graph :
horizontal lines, vertical lines, and both horizontal and
vertical lines . Grid lines are drawn on the graph so that
they appear behind the information . However, you
should keep in mind that grid lines may obscure some
line and high-low-close graphs .

To add or

	

1. Select "OPTIONS" from the Visi On menu .
remove grid lines 2. Scroll the options sheet until the Grid Lines option

is visible, as illustrated in Figure 5-13.
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Figure 5-12 . The background color option is near the middle of the
Graph options sheet. Depending on your window size, you may
have to scroll it into view. This option controls whether your graph
is drawn on a black or white background .
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Figure 5-13 . The grid lines option is near the beginning of the
Graph options sheet but, depending on your window size, you may
have to scroll it into view. Grid lines help you reference your axis
values and plotted points .

3. Select one of the following :
∎ "both" if you want to use both horizontal and

vertical grid lines on your graph .
∎ "horizontal only" if you want to use only

horizontal lines on your graph .
∎ "vertical only" if you want to use only vertical

lines on your graph .
∎ "none" if you do not want grid lines

on your graph .

If your options sheet redraw mode is set to "automatic ;"
the graph will be redrawn immediately using the new
grid lines option .

If the redraw mode is set to "manual ;" you must redraw
the graph to see the effect of the new grid lines option .
(See "Automatic and Manual Options" earlier in this
chapter for more information .)
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Overlaying Graphs
You can use the overlay technique to add an additional
series, graph type, or combinations of both to an
existing graph . With the exception of pie and X-Y
graphs, you can overlay any two graph types . You can
only overlay X-Y graphs with other X-Y graphs . Pie
graphs cannot be overlaid .

There is no command to overlay a graph . Instead of
choosing "erase" to clear the the previous graph as
Chapter 4, "Turning Series into Graphs ;" instructs you,
you select a new chart type, new series, or both, and
plot the new graph on top of the previous graph . The
newly created graph is rescaled to include all of the
series data points, and the new series are added to the
legend.

You must consider the periodicity of each series you
use when constructing an overlay graph . Because both
graphs will use the same axes, the periodicity of each
overlaid series must match that of the original series .

Figure 5-14 . An overlay graph can add a new series to an existing
graph, combine two types of graphs with the same series information
to create a new graph style, or bring two different charts into the
same picture. Creative use of the overlay technique can reveal very
much about relationships among your series .
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The individual beginning and ending points can be
different, because the graph will rescaled when it is
redrawn. (For information about series periodicity, see
"Periodicity" in Chapter 3.)

When choosing what graph types to overlay, be careful
to avoid obscuring or covering the previous graph. For
instance, if a stacked bar graph overlays a comparative
bar graph using the same series, only the stacked bar,
which was drawn last, will be readable .

To create an

	

1. Create the first graph .
overlay graph (See Chapter 4, "Turning Series into Graphs," for

additional information.)

2. Select the new series, new graph type, or both, as if
you were going to create a new graph .
Review your graph type. If you are overlaying an X-Y
graph, you must use another X-Y graph . Pie graphs
may not be used in overlays. Any other type of
graph (area, bar, line, and high-low-close) may be
overlaid .
If you are selecting new series, they must have the
same periodicity as the series you plotted in
step 1 .

3. Select "plot:" (Do not select "erase .")

4. The graph is redrawn with your new selections
added . The overlaid selections are drawn last .

If the graph created in step 1 contains labels, these
labels are redrawn on the new graph . However, because
the graph may have been rescaled, the labels may now
appear in a different location or describe situations that
no longer apply. For additional information on moving,
removing, and replacing these labels, see "Labeling
Your Graph" earlier in this chapter .

Changing the Scale (Height or Width)
of Your Graph

In line, bar, area, and high-low-close graphs, each axis
has a separate and distinct function . (Pie graphs have
no scale.) In X-Y graphs, both axis represent individual
series values .)
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Figure 5-15 . The scales of your X and Y axes define the beginning
and ending values of each axis .

The X-axis scale reflects the periodic values of each
series. These are usually the time period that each from
which each series value is referenced . When the
Visi On Graph program draws your graph, the X-axis
scale includes all of the values that will fit from a series .
Changing the scale, diminishing the ending value, or
increasing the starting value may prevent some values
from being plotted if these values then fall before or
beyond the graph's scale .

Figure 5-16 illustrates the effect of changing the scale of
the X axis .

The Y-axis scale reflects the maximum and minimum
values of the series used in the graph . When the
Visi On Graph program draws your graph, the Y-axis
scale is set to include the smallest and largest values .
Changing the scale, setting a smaller highest value, or
setting a larger beginning value may cause some values
to be truncated or not show on the graph at all, if these
values are then above or below the graph's scale .
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Figure 5-16. Changing the X axis, in this case increasing the
minimum value and decreasing the maximum value, can focus the
graph on a particular part of the series .

Figure 5-17 illustrates the effect of changing the scale of
the Y-axis .

You do not have to specify the scale of a graph before
you draw it . The programs preset values for each axis
include all of the points in each series and display each
value fully in the graph . The "rescale" command allows
you to change these values, giving you control over the
graph's graphic emphasis .

You must have a graph in the Graph display before you
begin to rescale .

To change the

	

1. Select "rescale ."
scale of a graph 2 . Select the axis you are rescaling .

∎ "x-axis"
∎ "y-axis"
∎ "both" (causes both the X-axis and Y-axis to be

rescaled)
The program asks you to select a rescaling mode .
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Figure 5-17. Changing the Y axis, in this case increasing the
maximum value and decreasing the minimum value, can often
present a different view of your information .

3. Do one of the following :
∎ Select "automatic" if you want the Visi On Graph

program to rescale the axes .
The graph is redrawn. You return to the Graph menu .
You have completed the rescaling procedure . Do not
continue to step 4.

∎ Select "manual" if you want to enter the
beginning, and ending values for the scale(s)
yourself .
The program asks you for each scale values .

4. There are several questions the program asks you
when you choose to manually rescale. Answer each
of the following questions as the program asks for
them:
∎ If the graph is an X-Y graph, the program

prompts for each of the following values
separately :
-Beginning value
-Ending value
-Number of divisions along the Y axis, or along

both axes if the graph is an X-Y graph .
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C' If any other graph type is used, the questions will
be different for each axis .

∎ When the X axis is rescaled, the program asks for
the:
-Start year
-Start period
-End year
-End period
When the Y axis is rescaled, the program asks
for the :
-Beginning value
-Ending value
-Number of divisions along the Y axis

The current value, which is shown beside each prompt,
can be selected by pressing (ENTER). When you are asked to
supply a new number of divisions for either axis, the
range of acceptable values appears on the prompt line
in brackets .

In either case, to enter a new value, type the value
followed by (ENTER).

After you have rescaled, the new scales for each axis
will not change until you select "erase" or use these
same steps again to change them . It is important to
remember that when the program first draws a graph,
the scales are set to include each point in the graph . To
reset changed scales to these original scales, select
"automatic" in step 3 above .

GRAPH"
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Printing a Series

Printing a Series 6-1

You can print both the series and graphs you create
within the Visi On Graph' program . If you have used
print commands in other Visi On" programs, you will
find the Visi On Graph program uses a similar
procedure. If you have not used this command in other
Visi On programs, descriptions of all of the commands
related to these tasks are available to you in the
following sections .

Any series can be printed directly from the Edit display,
giving you a paper copy of all of the values in all of the
series currently in the display .

The graphs you create with the Visi On Graph program
can be printed in a number of ways, from a single
graph on a page to four different graphs on a single
page.

You can print in two different ways . The first of these is
to print the series or graph to a printer connected to
your computer. This is referred to as local printing .

If you do not have a printer connected to your
computer, or want to print the series or graph on
printer connected to another computer, you may have
the Visi On Graph program store the printed graph or
series in the Visi On Archives transmittal folder . Later,
when you have connected a printer to your computer or
have taken the contents of the transmittal folder to
another computer that has the printer attached to it,
you may print any of these series or graphs . This
process is referred to as remote printing .

Additional information on printing in general and the
transmittal folder in particular is found in the Visi On
User's Guide .

With the "hardcopy" command of the Edit menu, you
can print the series values used in a graph. At any time
during your editing session-before, during, or after
the editing-you can print all of the series shown in the
Edit display. This printed listing of your series can be
used for your own reference, to plan changes to the
series, or as an attachment to your printed graph .

Begin this command with the series you want to print
showing in the Edit display.
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To print the

	

1. Select "hardcopy" from the Edit menu .
series in the Edit

	

You are asked where you want to print the series .
display

2 . Select :
∎ "local-print" if you want to use a printer

connected to your computer, as selected in the
Edit option sheet .

∎ "remote-print" if you want to print the series in
your transmittal folder. See the Visi On User's
Guide for information about series that are
printed in the transmittal folder.
If you select "remote-print" :
You are prompted for the printer model on which
you will eventually print the series . All of the
installed printer models are displayed .
-Select the model on which you will print the

series .
You are prompted for the name that the printed
series will be saved under in the transmittal
folder.

-Type a name for the printed series and press
(ENTER)

The Edit options sheet appears on the right-hand
side of the Edit display, showing your optional
choices for formatting printed output . The
highlighted choices will be used unless you change
them .
For a description of each of these options, see
"Changing Print Options" later in this chapter .
The prompt asks you whether you want to use these
options .

3. Select :
∎ "yes" if you want to print using the highlighted

selections.
∎ "no" if you need to change any of the selections

before printing .

You are returned to the Edit menu . Change the options
as you need and then begin this process again with
step 1 .

If you select "yes;" the series are printed on your
printer, or in the transmittal folder as indicated .
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The printed series are a useful tool for editing when
series are too long to be shown in the Edit display, or
when you want to attach the series to a printed chart .

Printing a Graph
After you create a graph, you will probably want to
make a printed copy of it for your report or
presentation . The Visi On Graph program allows you to
do more than simply print a single graph on a sheet
of paper :

•

	

You can preview the printed graph, seeing it in
exactly the proportions it will take when it is printed
on paper.

•

	

You can divide your printed page into two equal
sections (either horizontally or vertically) or four
equal quarters, each capable of showing a separate
graph . The Visi On Graph program calls this process
partitioning.

•

	

You can add a main, sub-, or bottom title to the
partitioned page, by using the "label" command of
the Print menu .

•

	

You can print the single or partitioned page in any
size (up to 11 by 17 inches square) .

Printing several graphs on one page is, of course, an
option . If you want to print your current graph, follow
the instructions in the next section, "Printing a Single
Graph ." If, however, you want to print several graphs
on one page or add page labels to your printed graph,
read "Partitioning the Graph" and "Adding Titles to the
Printed Page" later in this chapter .

Whether you are printing a single graph or a
partitioned graph, the process of sending it to the
printer is the same .

If you have already partitioned a graph or added page
titles with the "title" command, you may begin this
process at step 2 .
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If you want to print a graph currently displayed in the
Graph display, begin this process at step 1.

To print a single

	

1. Select "Print" from the Graph main menu .
graph

	

The Print menu is shown as illustrated in Figure 6-1 .

2 . Select "hardcopy."
You are asked where you want to print the graph .

3. Select :
∎ "local-print" if you want to use a printer

connected to your computer, as selected in the
Print options sheet .

∎ "remote-print" if you want to print the graph in
your transmittal folder. See the Visi On User's
Guide for information about graphs that are
printed in the transmittal folder .
If you select "remote-print :"
You are prompted for the printer model on which
you will eventually print the graph . All of the
installed printer models are displayed .
- Select the model on which you will print the

graph .
You are prompted for the name that the printed
graph will be saved under in the transmittal
folder.

-Type a name for the printed graph, followed by
(ENTER)•

The Print options sheet appears on the right-hand side
of the Edit display, showing your optional choices for
formatting printed output . The highlighted choices will
be used unless you change them .

For a description of each of these options, see "Options
in the Edit Menu" later in this chapter .

The prompt asks you whether you want to use these
options .

4. Select :
∎ "yes" if you want to print using the highlighted

selections .
∎ "no" if you need to change any of the selections

before printing .



To begin
partitioning your
page
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Figure 6-1 . The Print menu allows you to print the graph shown
in this display by selecting "hardcopy ."

You are returned to the Print menu . Change the options
as you need and then begin this process again with
step 1 .

If you select "yes;" your printer then prints the graph or
the graph is printed in the transmittal folder as
indicated .

This procedure works for both single and partitioned
displays . Read "Partitioning the Graph," "Adding Titles
to the Printed Page," and "Changing Print Options" for
additional information about enhancing your printed
graphs and charts .

Partitioning the Graph
You can print up to four graphs on a page by using the
partition option and the commands that work with it .
You can select the partition option at any time when
you are in the Print menu .

1 . Select "OPTIONS" from the Visi On menu .
You are prompted to select the window to change
the options .

2 . Select the Visi On Graph window you are using .
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Figure 6-2 . The partitioning options at the top of the Print options
sheet allow you to create a print display with one graph, two graphs
divided vertically, two graphs divided horizontally, or four graphs on
a single page .

3. If you need to, scroll the options sheet until you can
see all of the partitioning options, as illustrated in
Figure 6-2 .

4. Select :
∎ "none" if you do not want the page to be

partitioned .
∎ "vertical" if you want two partitions divided

vertically.
∎ "horizontal" if you want two partitions divided

horizontally.
∎ "quadrants" if you want four partitions .

The page is then redrawn with the new partitioning
option .

After you have partitioned the display, you will
probably want to put a few graphs into it . Putting
graphs into a partitioned display is covered in the next
section .



Figure 6-3. The four types of display partitioning. The page with
no partitioning (none) can hold only one graph . Vertical and
horizontal pages can both hold two graphs, oriented vertically or
horizontally. The quadrants page can hold four graphs .
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Putting graphs in a partitioned display
After you partition the page the way you want, you can
begin filling it with graphs.

To add graphs to 1. Select "put" from the Print menu .
the partitioned

	

A list of the frozen graphs in the working folder is
page

	

displayed. Additional selections of "current" and
"done" are also shown .

2 . Select the names of the graphs you want to add to
the partitioned page .

If you select "current," the graph that is currently
shown in the Graph display will be used .

You may select as many graphs as can be displayed
in the current partition . For instance, if you have
divided the display into two horizontal or vertical
partitions, you can select two graphs from the list .
After you select the second graph, you are returned
to the Print menu .

If you are selecting fewer than the total number of
graphs that your partitioning can hold, select "done"
to return to the Print menu .

The program prompts you to select the location for
the first graph .

3. Select the partition you want to fill with the
selected graph .
If there is a graph in the selected partition, it will be
replaced with the new graph .
Any other selected graphs will be placed in the
display from left to right, top to bottom, in the order
that they were selected .

You may find that you would rather have the graphs
displayed in other locations, or that one or more of the
graphs should be erased . You can use the "move ;"

"swap, "copy," and "erase" commands to move graphs
around on the partitioned page .



Figure 6-4 . To move
a graph between
partitions, select the
"move" command .
(1) Select partition (a),
followed by
(2) partition (b) . The
graph in partition (a)
moves to partition (b) .
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Moving one graph to another partition
1. Select "move ."

2 . Select the partition with the graph you want to
move .

3. Select the partition where you want to put that
graph.
The new graph replaces any graph in that partition .

The graph is erased and redrawn in the new partition .

To move a graph
to another
partition
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Switching the positions of two graphs
1. Select "swap ."

2 . Select the first partition that contains a graph you
want to move .

3. Select the second partition that contains a graph you
want to move .
The graphs are erased from their old partitions and
redrawn in the switched positions.

Figure 6-5 . To

switch graphs in
different partitions	
select the "swap"
command. Select
(1) Partition (a)
followed by
(2) partition (b) . The
graph in partition (a)
moves to partition (b) ;
the graph in
partition (b) moves to
partition (a) .

To switch the
positions of two
graphs



Figure 6-6. To copy
a graph into another
partition, select the
"copy" command .
(1) Select partition (a),
followed by
(2) partition (b) .
The graph in
partition (a)
is copied into
partition (b) .
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Copying a graph into a different partition

1 . Select "copy"

2. Select the partition with the graph you want to copy .

3. Select the partition where you want to put the copy
of the selected graph .

A copy of the graph is drawn in the new partition .

To copy a graph
into a different
partition
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Figure 6-7. To erase
a graph from a

partition, select
the "erase" command .
(1) Select partition (a) .
(2) The graph in
partition (a) is erased .

Erasing in the Print display

The "erase" command in the Print menu allows you to

erase a graph, or a title that has been entered in the
Print menu, from the Print display.

1. Select "erase ."

2 . Select the partition or title that you want to erase .

The selected partition or title is erased . No other

partition or title is affected .

To erase a graph
or title from the
Print display
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You add three titles (in addition to those you have
added in the Annotate menu) to the printed page with
the "title" command of the Print menu . These titles are
not saved with the graphs, but they are shown in the
Print display and will appear on the printed page .

Just as you use the Annotate menu's "title" command
to enhance an individual graph, you can add details to
explain the graphs in the printed page by using the
"title" command .

You can add three types of titles to the partitioned
page :

•

	

"main" adds a title at the top of the printed page .

•

	

"subtitle" adds a title one line below the main title .

•

	

"bottom" adds a title below the printed page .

Figure 6-8. Three types of titles that can be added to a printed
page: the main title, -the subtitle, and the bottom title .
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1. Select "title" from the Print menu .

2 . Select the type of title :
∎ "main'
∎ "subtitle"
∎ "bottom"

3. Type the title you want to place on the display and
press (ENTER).
The title appears, centered, in the position you
selected .

If you want to replace any of the titles you have
entered, begin again at step 1 and select the title you
want to replace. The old title will be erased and your
new title will be shown .

If you want to remove any of the titles you have
entered, see "Erasing in the Print display" earlier in this
chapter.

Changing Print Options
You can control the size, shape, and number of copies
you print with the options sheets in both the Edit and
Print displays .

Selecting the "OPTIONS" command of the Visi On
menu opens either of these options sheets . Choosing a
new option is as simple as scrolling to it and then
selecting it . Selecting "done" from the options sheet
menu closes the options sheet .

The following sections describe the options sheets
found in both the Edit and Print menus . For additional
information on options and the "OPTIONS" command,
see the Visi On User's Guide.

Changing number of copies

You can change the number of copies that are printed
each time "hardcopy" is selected . This option is preset
to print one copy.

To change the

	

1. Select the number to the right of "Number of
"Number of

	

copies:"
Copies" option

	

2 Press (E N D) and then type the number of copies
you require and press (ENTER) The number may be
between one and 99 .

To add titles to
your printed
page



• change the
"Pause After
Page?" option

•

	

change the
"Length,'
"Width,' "Top
Border" or
"Left Border"
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Pause after page
If you are printing more than one copy of your graph
on single sheets of paper, you may want the program to
pause between printed copies so that you can insert the
next sheet in your printer .

1 . Select one of the following :
∎ Select "yes" if you want the Visi On Graph

program to pause between printed pages .
∎ Select "no" if you do not want the Visi On Graph

program to pause between printed pages .

Changing layout options
The layout options let you change the size and borders
of your printed pages .

The "Length" or "Width" measurements can be a
maximum of 17 inches each .

The "Top" and "Left" borders can be any size up to half
of the length or width (respectively) of the page . The
value you set for the "Top" border will also be used for
the bottom border, and the value you set for the "Left"
border will also be used for the right border .

1 . Select the number to the right of the layout option
you are changing .

2 . Press (E ND) ; then type the new value for the
option and press (ENTER) .

Selecting the printer
If you have more than one printer installed in your
Visi On system, you may want to specify which is to be
used for printing your Edit display or graph . The "Print
Document On" option of both the Edit and Print
options sheets gives you this control .

The "Print Document On" option will list all of the
installed printers available to you when you select the
options sheet . The preset printer will be the first one
that was installed .

•

	

select a new 1. Select the name of the printer you want to use to
printer

	

print your Edit display or graph .



6-16 Printing

This list of available printers may not be the same in the
Print options sheet as it is in the Edit options sheet . It is
possible that you may have printers installed in the
system that are not able to print a graph . For additional
information on installing and using printers, see the
Visi On User's Guide .
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Transferring Information
into the Visi On Graph TM Program

The "TRANSFER" command in the Visi On'" menu lets
you copy information from one window to another.
Within the Visi On Graph" program, you can use the
"TRANSFER" command to copy parts of series into
other series, or duplicate an entire series within the
same Edit display .

In addition, you can transfer information from other
Visi On program windows into your Visi On Graph
window. You can transfer such items as :

•

	

An entire chart from a different Visi On Graph
window.

•

	

Other series from a different Visi On Graph window.
Each series carries its own periodicity, start date,
name, and values .

•

	

A row or column of values from a spreadsheet .
Data in the row becomes a new series using the
preset periodicity, start date, and name .

•

	

Several rows or columns of values .
Data in each row or column becomes a separate
series with the preset periodicity, start date ; and
names. Any missing entries are replaced by zero
values. Text is also replaced by zeros .

If the information you try to transfer would cause the
Visi On Graph program to exceed its maximum limits,
you are given an error message instead of the
transferred values .

Those limits are:

•

	

Twenty-four series in the working folder.

•

	

Eight graphs. (Each transferred graph creates
another frozen graph in the working folder.)

•

	

One thousand numbers in any one series .

•

	

Twelve series in the Edit display .

If you are unable to transfer information into the
Visi On Graph program because you would exceed one
of these maximums, you may :
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•

	

Open another Visi On Graph window.

•

	

Copy some series or frozen graphs from the working
folder into the current folder ; then remove them
from the working folder. See Chapter 2, "Saving,
Getting, and Organizing Series and Graphs ;" for
additional information .

•

	

Remove any series or frozen graphs you no longer
need from the working folder. See Chapter 2,
"Saving, Getting, and Organizing Series and
Graphs," for additional information .

41 Clear any series you no longer need from the Edit
display.

The following sections discuss how you can transfer
graphic and numeric information into a Visi On Graph
window from another Visi On window. If you are
transferring from another Visi On Graph window, you
should read "Selecting Graphs to Be Transferred" and
"Selecting Numeric Information to Be Transferred" later
in this chapter.

However, if you are transferring into or from another
Visi On program, you should review its User's Guide
for transfer requirements . See the Visi On User's Guide
for information about "TRANSFER" and other Visi On
commands.

Selecting the Target Area for Incoming Graphs
One of the strengths of the Visi On system is that it
allows you to directly use the work you have done with
one Visi On program in another Visi On program
without duplicating your previous effort . The
"TRANSFER" command is the basis of that ability . This
section discusses the use of the "TRANSFER"
command and gives instruction on selecting a target
area within a Visi On Graph window for an
incoming graph .

Before you begin :

M The Visi On Graph program can only accept a
transferred graph in the Graph display . The target
window should show the Graph display. The
display may already contain a graph, but it will be
erased by the incoming transferred graph .
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∎ You should have selected the Visi On "TRANSFER"
command and specified a graph from another
window as the source area for the transfer. If the
source information is coming from another Visi On
Graph window, see "Selecting Graphs to Be
Transferred" later in this chapter for this
information .

∎ The Visi On menu line requests the destination
window for the transferred graph .

Continue with the transfer :

1. Select the window you are transferring
the graph into.

2 . Select any location in the Graph display of the target
window.
The graph is then transferred into the Visi On Graph
program .

Note : If you are transferring unnamed items, such as a
portion of table or a spreadsheet, these new items are
given temporary names . These names, such as
"Transfer01," will be used again in subsequent transfers
and will replace the previously transferred items . If you
want to make such a transfer permanent, you must
change the new series names using the "parameters"
command in the Edit menu . For additional information
on using the parameters command, see "Changing
Series Names, Periodicities, and Dates" in Chapter 3 .
The graph becomes the current graph and is shown in
the Graph display. If another graph was shown there
before the transfer began, it is erased . The series are
put in the working folder and can be edited in the Edit
display.
Once the transfer is complete, there is no difference
between transferred information and any other
information in the program : series can be edited,
graphs can be modified, and any item that appears in
the working folder can be saved in the current folder.

Selecting the Target Area
for Incoming Numeric Information

One of the strengths of the Visi On system is that it
allows you to directly use the work you have done with
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one Visi On program in another Visi On program
without duplicating your previous effort. The
"TRANSFER" command is the basis of that ability . This
section discusses the use of the "TRANSFER"
command and gives instruction on selecting a target
area within a Visi On Graph window for incoming
numeric information .
Before you begin :
•

	

You should have a Graph or Edit display in the
destination window.

•

	

You should have selected the Visi On "TRANSFER"
command and specified the numeric information
from another window as the source area for the
transfer. If the source information is coming from
another Visi On Graph window, see "Selecting
Numeric Information to Be Transferred" later in this
chapter for this information .

•

	

The Visi On menu line requests the destination
window for the transferred graph .

Continue with the transfer :

1 . Select the window you are transferring the numeric
information into .

2. Select the target area, select either :
I Any location in the Graph display.
∎ The first series column you want to fill with

transferred information .
The information is transferred into the Visi On
Graph program. Its appearance will vary, depending
upon what program display was shown at the time
of the transfer.
If the display was :

The Edit display, the series are shown . The new
information can be used to create one or more
new series, or add values to an existing series,
depending upon how the target area is specified .

∎ The Graph display, the numeric information is
plotted as a graph, using the current graph style .
The new series are added to the working folder.
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Note : If you are transferring unnamed items, such as a
portion of table or a spreadsheet, these new items are
given temporary names . These names, such as
"Transfer01," will be used again in subsequent transfers
and will replace the previously transferred items . If you
want to make such a transfer permanent, you must
change the new series names using the "parameters"
command in the Edit menu . For additional information
on using the parameters command, see "Changing
Series Names, Periodicities, and Dates" in Chapter 3 .

Once the transfer is complete, there is no difference
between transferred information and any other
information in the program: series can be edited,
graphs can be modified, and any item that appears in
the working folder can be saved in the current folder .

Transferring Information
out of the Visi On Graph" Program

As well as accepting information from other programs,
the Visi On Graph program can share its information
with other Visi On system programs . This ability can
save you much time, allowing you to apply the
information you enter or create in the Visi On Graph
program to projects in other Visi On system programs .

You can transfer information in the Visi On Graph
program to another product window. You can transfer :

•

	

An entire chart .
The chart is transferred, complete with series
information, selected options, ranges, and
annotation .

•

	

Series (one or more) .
Each series transferred carries the periodicity, start
date, starting period, series name, and values .

•

	

A series or part of a series .
Several numbers from one series, or several series
can be transferred .
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Selecting Graphs to Be Transferred

To select graphic
information for
transfer from the
Visi On Graph
program :

The following sections discuss how you can transfer
graphic and numeric information out of a Visi On
Graph window from another Visi On window . If the
transfer is going to another Visi On Graph window, you
should read "Selecting the Target Area for Incoming
Graphs" and "Selecting the Target Area for Incoming
Numeric Information' earlier in this chapter .

However, if you are transferring into another Visi On
program, you should review its User's Guide for
transfer requirements . See the Visi On User's Guide for
more information about "TRANSFER" and other
Visi On commands .

One of the strengths of the Visi On system is that it
allows you to directly use the work you have done with
one Visi On program in another Visi On program
without duplicating your previous effort . The
"TRANSFER" command is the basis of that ability . This
section instructs you in the use of transfer and how to
select graphs to be transferred out of a Visi On Graph
window.

In the Visi On Graph program the only place that can
be used as the source of a transferred graph is the
Graph display.

You must be in the Graph display before selecting
"TRANSFER" from the Visi On menu .

1. Select "TRANSFER" from the Visi On menu .
The program prompts you for the source window of
the transfer.

2 . Select the Visi On Graph window that contains the
information you want to transfer.
The program prompts you for the start of the region
to be transferred .



To select numeric
information for
transfer from the
Visi On Graph
program
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3. Select any part of the graph .
The program prompts you for the end of the region
to be transferred .

4. Again, select any part of the graph .

The source area is now defined . If you are transferring
to another Visi On Graph window, see "Selecting the
Target Area for Incoming Graphic Information" earlier
in this chapter. If you are transferring to another
Visi On program, see its User's Guide for transfer
requirements.

Selecting Numeric Information to Be Transferred
One of the strengths of the Visi On system is that it
allows you to directly use the work you have done with
one Visi On program in another Visi On program
without duplicating your previous effort . The
"TRANSFER" command is the basis of that ability. This
section instructs you in the use of transfer and how to
select series and parts of series to be transferred out of
a Visi On Graph window .

You can transfer a series, a selected section of a series,
several series, or selected sections of several series .

You must be in the Edit display before selecting
"TRANSFER" from the Visi On menu .

1 . Select "TRANSFER" from the Visi On menu .
The program prompts you for the source window of
the transfer.

2. Select the Visi On Graph window that contains the
information you want to transfer.
The program prompts you for the start of the region
to be transferred .



Transferring Information

Figure 7-1 . When
selecting the source
area of a transfer from
the Edit display, select
the name of the series
you want to transfer.

Figure 7-2 . When
selecting the source
area of a transfer from
the Edit display, select
the first number in the
range of numbers you
want to transfer.

3. If you are transferring :
One series, select the series name, as illustrated
Figure 7-1 .

Part of one series, select the first number in the
range of numbers you want to transfer, as
illustrated in Figure 7-2 .



Figure 7-3. When
selecting the source
area of a transfer from
the Edit display, select
the name of the
leftmost series you
want to transfer.

Figure 7-4. When
selecting the source
area of a transfer from
the Edit display, select
the first number from
the leftmost series in
the range you want to
transfer.
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More than one series, select the name of the
leftmost series you want to transfer, as illustrated
in Figure 7-3 .

Part of more than one series : select, from the
leftmost series you are transferring, the first
number in the range of numbers you want to
transfer, as illustrated in Figure 7-4 .
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The menu line prompts you for the end of the region
area transferred .

4 . If you are transferring :
One series, again select the name of that series,
as illustrated in Figure 7-5 .

Part of one series, select the last number in the
range of numbers you want to transfer, as
illustrated in Figure 7-6 .

J More than one series, select the name of the
rightmost series you want to transfer, as in
Figure 7-7.

Figure 7-5 . When prompted to selecting the end of the region of a
transfer from the Edit display, select the series name a second time .
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Figure 7-6. When selecting the end of the region of a transfer from
the Edit display, select the last number in the range of numbers you
want to transfer .

Figure 7-7. When prompted to select the end of the region of a
transfer from the Edit display, select the name of the rightmost series
you want to transfer.
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Figure 7-8. When you select the end of the region of a transfer from
the Edit display, select the last number in the range of numbers you
want to transfer.

Part of more than one series, select, from the
rightmost series you are transferring, the last
number in the range of numbers you want to
transfer, as illustrated in Figure 7-8 .

The source area is now defined . If you are transferring
to another Visi On Graph window, see "Selecting the
Target Area for Incoming Numeric Information" earlier
in this chapter. If you are transferring to another
Visi On program, see its User's Guide for transfer
requirements .
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Each exercise in this chapter introduces you to a basic
type of graph or application of the program . The
exercises in this chapter cover :

•

	

Single-series line graphs

•

	

Multiple-series line graphs

•

	

Bar graphs

•

	

Comparative bar graphs

•

	

Stacked bar graphs

•

	

Pie graphs

•

	

X-Y graphs

•

	

High-low-close graphs

•

	

Mixed graph types

•

	

Creating text pages

Each example guides you, step by step, through the
creation of the graph . If you require additional
information, see Chapter 4, "Turning Series
into Graphs ."

Entering the Sample Series
Each of the exercises requires you to have in the
working folder at least one of the following three series
of data: the INCOME, X-Y, and HIGH-LOW-CLOSE
series. Directions for entering these three sample series
are given in the following sections .

The series required for each exercise are listed at the
beginning of the exercise . Unless you are going to do all
of the exercises, there is no reason to enter all series at
once. Look at each exercise and see what series it
requires; then, using the Visi On Graph'" editing
commands, enter the required series .

Some of the series are used in more than one exercise .
You may want to save them for later use, with the
commands described in Chapter 2 : "Saving, Getting,
and Organizing Series and Graphs :'

The following sections guide you through creating the
series : selecting the series, entering the periodicities,
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The INCOME Series

start dates, and series names . The series information is
listed next. If you need more help with entering the
sample series, see "Creating New Series" in Chapter 3 .

Beginning from the Graph main menu :
1 . Select "Edit ."

There should not be any series in the Edit display .
If there are series in the display, you must use the
"clear" command in the Edit menu to remove them
from the display. Instructions on using the "clear"
command can be found in "Clearing Series from
the Edit Display" in Chapter 3 .

2 . Select "series" from the Edit menu .

3. Select "new series :"

4. Select "done ."

5. Enter 3 as the number of new series to create .

6. Enter 12 as the series periodicity .

7. Enter Natlnc as the name of the first series .

8. Enter 1983 as the series beginning year .

11 . Select "add ."

13. Select "done."

These series are now ready for plotting .

9. Enter 1 as the series beginning period .

10. Enter the series names and accept the defaults for
periodicities .
Type:
Arealnc
Eurolnc

12 . Enter the information as it is displayed in
Figure 8-1 . Do not enter the shaded information .
This information will appear in the Edit display as
you make your entries . Again, if you need help
entering this information, see "Creating and
Changing Your Series" in Chapter 3 .



The X-Y Series

Figure 8-1 . The INCOME series.

From the Graph main menu :

1. Select "Edit ."

There should not be any series in the Edit display . If
there are series in the display, you must use the "clear"
command in the Edit menu to remove them from the
display. Instructions on using the "clear" command can
be found in "Clearing Series from the Edit Display" in
Chapter 3 .

2 . Select "series" from the Edit menu .

3. Select "new series :'

4. Select "done ."

5. Enter 2 as the number of new series .

6. Enter 1 as the series periodicity .

7. Enter X-Series as the name of the first series .

8. Enter 1 as the series beginning year.

Entering the Sample Series 8-3

9. Enter the second series name, accepting the default
for the second series beginning period .
Type:
Y-Series

10. Select "add."
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Figure 8-2 . The X-Y series .

11 . Enter the information as it is displayed in the Figure
8-2 . Do not enter the shaded information. This
information will appear in the editing window as
you make your entries . Again, if you need help
entering this information, see "Creating and
Changing Your Series" in Chapter 3 .

12. Select "done."

These series are now ready for plotting .

The HIGH-LOW-CLOSE Series

Beginning from the Graph main menu :

1 . Select "Edit ."
There should not be any series in the Edit display . If
there are series in the display, you must use the "clear"
command in the Edit menu to remove them from the
display. Instructions on using the "clear" command can
be found in "Clearing Series from the Edit Display" in
Chapter 3 .

2 . Select "series" from the Edit menu .

3 . Select "new series ."

4 . Select "done ."

5 . Enter 3 as the number of new series .



Figure 8-3 . The HIGH-LOW-CLOSE series.

6. Enter 1 as the series periodicity .

7. Enter High as the name of the first series.

8. Enter 1977 as the series beginning year .

9. Enter the series names, accepting the defaults for
the periodicities .
Type :
Low
Close

10. Select "add ."

12 . Select "done ."

These series are now ready for plotting .

Creating a Single-Series Line Graph 8-5

11 . Enter the information as it is displayed in
Figure 8-3. Do not enter the shaded information .
This information will appear in the Edit window as
you make your entries . Again, if you need help
entering this information, see "Creating and
Changing Your Series" in Chapter 3 .

Creating a Single-Series Line Graph
This graph uses the INCOME series . For information
on entering these series, see "Entering the Sample
Series" earlier in this chapter .
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Figure 8-4. Single-series line graphs are commonly used to keep
track of single-point information, such as physical measurements,
temperatures, and percentages .

Beginning from the Graph main menu :

1 . Select "data' from the Graph main menu ; then select
"series" from the data type menu.

2. Select "Natlnc" from the available series .

3. Select "done" from the series menu .

4. Select "style" from the Graph main menu .

5. Select "line" from the available graph types .

6. Select "both" from the line type menu .

7. Select "erase" ; then select "plot" from the Graph
main menu .

Once the graph is drawn, you can overlay it with
another series or type of graph, add labels and change
display options, or print it directly. For additional
information see Chapter 5, "Enhancing Your Graphs"
and Chapter 6, "Printing ."
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Creating a Multiple-Series Line Graph
This graph uses the INCOME series . For information
on entering these series, see "Entering the Sample
Series" earlier in this chapter .

Beginning from the Graph main menu :

1. Select "data' from the Graph main menu ; then select
"series' from the data type menu .

2 . Select "Natlnc" from the available series .

3. Select "Arealnc" from the available series .

4. Select "Eurolnc" from the available series .

5. Select "done" from the series menu .

6. Select "style" from the Graph main menu .

7 Select "line" from the available graph types .

8. Select "both" from the line type menu .

Figure 8-5. Multiple-series line graphs are commonly used to keep
track of several series of single-point information, such as physical
measurements, temperatures, and percentages . Because the lines are
drawn next to each other, you can easily compare the individual
series values .
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Creating a Bar Graph

GRAPH-

9. Select "erase"; then select "plot" from the Graph
main menu.

Once the graph is drawn, you can overlay it with
another series or type of graph, add labels and change
display options, or print it directly . For additional
information see Chapter 5, "Enhancing Your Graphs"
and Chapter 6, "Printing ."

This graph uses the INCOME series . For information
on entering these series, see "Entering the Sample
Series" earlier in this chapter .

Beginning from the Graph main menu :

1. Select "data" from the Graph main menu ; then select
"series" from the data type menu .

2 . Select "Eurolnc" from the available series .

3. Select "done" from the series menu .

Figure 8-6. Bar graphs are commonly used to keep track of
cumulative or volume information, such as sales, inventory, and
population .
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4. Select "style" from the Graph main menu .

5. Select "bar" from the available graph types .

6. Select "compare" from the bar graph type menu .

7. Select "erase" ; then select "plot" from the Graph
main menu .

Once the graph is drawn, you can overlay it with
another series or type of graph, add labels and change
display options, or print it directly . For additional
information see Chapter 5, "Enhancing Your Graphs"
and Chapter 6, "Printing ."

Creating a Comparative Bar Graph
This graph uses the INCOME series . For information
on entering these series, see "Entering the Sample
Series" earlier in this chapter .

Figure 8-7. Comparative bar graphs are commonly used to keep
track of several series of cumulative or volume information, such as
sales, inventory, and population . Because the bars are drawn next to
each other, you can easily compare the values of each of the series .
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Beginning from the Graph main menu :

1 . Select "data" from the Graph main menu ; then select
"series" from the data type menu .

2. Select "Natlnc" from the available series .

3. Select "Eurolnc" from the available series .

4. Select "done" from the series menu .

5. Select "style" from the Graph main menu .

6. Select "bar" from the available graph types .

7. Select "compare" from the bar graph type menu .

8. Select "erase"; then select "plot" from the Graph
main menu .

Once the graph is drawn, you can overlay it with
another series or type of graph, add labels and change
display options, or print it directly . For additional
information see Chapter 5, "Enhancing Your Graphs"
and Chapter 6, "Printing ."

Creating a Stacked Bar Graph
This graph uses the INCOME series . For information
on entering these series, see "Entering the Sample
Series" earlier in this chapter .

Beginning from the Graph main menu :

1 . Select "data' from the Graph main menu ; then select
"series" from the data type menu .

2. Select "Natlnc" from the available series .

3. Select "Eurolnc" from the available series .

4. Select "done" from the series menu .

5. Select "style" from the Graph main menu .

6. Select "bar" from the available graph types .

7. Select "stack" from the bar graph type menu .

8. Select "erase"; then select "plot" from the Graph
main menu .

Once the graph is drawn, you can overlay it with
another series or type of graph, add labels and change



Figure 8-8 . Stacked
bar graphs are
commonly used to keep
track of cumulative or
volume information,
such as sales,
inventory, and
population . Stacking
the bars displays the
cumulative total of
each of the individual
series.

Creating a Pie Graph 8-11

2 . Select "Natlnc" from the available series .

3. Select "Arealnc" from the available series .

4. Select "Eurolnc" from the available series .

5. Select "done" from the series menu .

6. Select "style" from the Graph main menu .

display options, or print it directly. For additional
information see Chapter 5, "Enhancing Your Graphs"
and Chapter 6, "Printing ."

Creating a Pie Graph
This graph uses the INCOME series . For information
on entering these series, see "Entering the Sample
Series" earlier in this chapter .

Beginning from the Graph main menu :

1 . Select "data" from the Graph main menu ; then
select "series" from the data type menu .

7. Select "pie" from the available graph types .

8 . Select "erase"; then select "plot" from the Graph
main menu .
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Figure 8-9 . Pie graphs show the contribution to the whole pie of
each period or series displayed in the graph . This type of graph is
commonly used where it is necessary to display each individual
value's contribution to the whole picture .

9. Type 1983 for the year to plot .

Creating an X -Y Graph

10. Type 1 for the period to plot .

Once the chart is drawn, you can add labels, change
display options, or print it directly . For additional
information see Chapter 5, "Enhancing Your Graphs"
and Chapter 6 "Printing ."

This graph uses the X-Y series. For information on
entering these series, see "Entering the Sample Series"
earlier in this chapter .

Beginning from the Graph main menu :

1 . Select "data" from the Graph main menu; then
select "series" from the data type menu .

2. Select "X-Series" from the available series .

3. Select "Y Series" from the available series .



Figure 8-10. An X-Y graph shows the correlation between series
points . This type of graph is commonly used to express the
relationship between series, such as rainfall and crop growth,
advertising expenditures and sales, and so forth .

4. Select "done" from the series menu .

5. Select "style" from the Graph main menu .

6. Select "X Y" from the available graph types .

7. Select "both" from the X-Y graph type menu .

8. Select "erase"; then select "plot" from the Graph
main menu.

Once the graph is drawn, you can add labels, change
display options, or print it directly . For additional
information see Chapter 5, "Enhancing Your Graphs"
and Chapter 6, "Printing ."

Creating a High-Low-Close Graph

Creating a High-Low-Close Graph 8-1 3

This graph uses the HIGH-LOW-CLOSE series . For
information on entering these series, see "Entering the
Sample Series" earlier in this chapter .
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Figure 8-11 . A high-low-close graph takes three series (or two for a
high-low graph), one composed of the high values for each time
point, a second for the matching low values for the same time points,
and a third that shows the final position at the end of the time
period. This type of chart is commonly used in recording and
presenting stock price histories on a daily or weekly basis ; it also has
many applications in physics and in mathematical distributions .

Beginning from the Graph main menu :
1 . Select "data" from the Graph main menu; then

select "series" from the data type menu .

2. Select "High" from the available series .

3. Select "Low" from the available series .

4. Select "Close" from the available series .

5. Select "done" from the series menu .

6. Select "style' from the Graph main menu .

7. Select "hi-to-cl" from the available graph types .

8. Select "erase" ; then select "plot" from the Graph
main menu .

Once the graph is drawn, you can overlay it with
another series or type of graph, add labels and change
display options, or print it directly . For additional
information see Chapter 5, "Enhancing Your Graphs"
and Chapter 6, "Printing ."



Mixing Graph Types
This graph uses the HIGH-LOW-CLOSE series . For
information on entering these series, see "Entering the
Sample Series" earlier in this chapter.

In this exercise you will draw a high-low-close graph
and then overlay it with a line graph . The overlaid line
graph connects the series that contribute to the high,
low, and close, and marks them with a symbol that is
displayed in the legend .

Beginning from the Graph main menu :

1 . Select "data" from the Graph main menu ; then
select "series" from the data type menu .

2 . Select "High" from the available series .

3 . Select "Low" from the available series .

4 . Select "Close" from the available series .

5 . Select "done" from the series menu .

Mixing Graph Types 8-15

6 . Select "style" from the Graph main menu .

Figure 8-12 . Mixing graph types often requires an experimental
and artistic attitude about displaying your information . A chart
using mixed graph types can often tell the viewer more than two
individual charts .
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Creating Text Pages

7. Select "hi-to-cl" from the available graph types .

8 . Select "erase"; then select "plot" from the Graph
main menu .

9 . Select "style' from the Graph main menu .

10. Select "line" from the available graph types .

11. Select "both" from the line type menu .

12. Select "plot" from the Graph main menu .

Once the graph is drawn, you can add labels, change
display options, or print it directly . For additional
information see Chapter 5, "Enhancing Your Graphs"
and Chapter 6, "Printing ."

This exercise does not use any of the series at the
beginning of this chapter.

Figure 8-13 . The Visi On' Graph program also allows you to use
its font capabilities to create short, eye-catching sections of text .
Such text pages can be used to head a memo, create a presentation
foil, describe a partitioned graph, or enhance almost any form of
written communication .



In this exercise you are creating an agenda list for a
stockholders luncheon . You will use both fixed titles
and text in the page, changing the font style for the
activities listing .

Beginning from the Graph main menu :

1. Select "erase."

2 . Select "Annotate ."

3 . Select "font" from the Annotate menu .

4. Select "boldface" from the font type menu .

5 . Select "title ."

6 . Select "main ."

7. Type Meeting Agenda

8. Select "title ."

9. Select "subtitle ."

10. Type Fall Quarter Stockholders Luncheon

11. Select "font" from the Annotate menu .

12 . Select "roman" from the font type menu .

13. Select "add" from the Annotate menu .

14 . Select "horizontal ."

15. Select the area about one inch below the F in "Fall ."

Creating Text Pages 8-17

16. Type :
Introduction
Minutes of the last meeting
Presentation by Northern Pulp Ltd .
Lunch
Election of Board
Open discussion

The text page is complete .

Once the text page is composed, you can add or edit
labels and change display options, or print it directly .
For additional information see Chapter 5, "Enhancing
Your Graphs" and Chapter 6, "Printing."
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Creating a Graph with Labels
and Enhancements

GRAPH"

No matter how obvious your graph's message is,
adding labels and using some of the programs options
can clarify or enhance its meaning . This section
demonstrates how you can label and change options in
a graph .

This graph uses the information from the HIGH-LOW-
CLOSE series. For information on entering these series,
see "Entering the Sample Series" earlier in this chapter .

In this exercise you will :

•

	

Draw a simple high-low-close graph

•

	

Overlay a line graph using the same series

•

	

Change some of the graph options

•

	

Label the finished graph
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Figure 8-14 . In your complete graphs, you will usually take
advantage of a couple of options, some labeling, and a font to make
one label stand out .
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Beginning from the Graph main menu :

Step 1 : Select the series and graph type ; then draw the
basic graph .

1 . Select "data" from the Graph main menu; then
select "series" from the data type menu .

2. Select "High" from the available series .

3. Select "Low" from the available series .

4. Select "Close" from the available series .

5. Select "done" from the series menu .

6. Select "style" from the Graph main menu .

7. Select "hi-to-cl" from the available graph types .

8. Select "erase" ; then select "plot" from the Graph
main menu .

Step 2: Because the same series will be used in the
overlay graph, you only have to select the new graph
type.

1. Select "style" from the Graph main menu .

2. Select "line" from the available graph types .

3. Select "both" from the line type menu .

4. Select "plot" from the Graph main menu .

You have finished drawing the graph . Now is a good
time to change some of the display options .
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Figure 8-15. Drawing the High-Low-Close Graph .

Figure 8-16 . Overlaying the Line Graph .
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Step 3 : Begin enhancing your graph by adding
horizontal grid lines to it .

1. Select "OPTIONS" from the Visi On menu .

2 . Select the Visi On Graph window.

3. Select "horizontal only" from the Grid Lines section
of the Graph options sheet .

Step 4: The legend is confusing because the same series
were used twice in the graph . This graph is fairly self-
explanatory, so we can remove the legend and make
more room for the plotted information.

1 . Remove the legend by selecting "No" from the
Legend section of the Graph options sheet .

Step 5 : A frame around the outside can add a nice
touch to your finished graph .

1. Add a frame around the graph by selecting "outer"
from the Framing section of the Graph options
sheet .
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Figure 8-17. Adding horizontal bars (3), removing the legend (4),
and adding a frame (5) to the graph .
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Step 6: You can make the values on the Y axis look
more like dollar figures . Change the Y-axis labels to a
dollar format (two fixed decimal places) . When you
have done this, close the options sheet .

1 . Scroll the options sheet to display the Y axis
attributes; then select "dollars" from the Y Axis
Attributes section of the Graph options sheet .

2. Select "done" from the Options sheet menu line .

Step 7: This graph needs some labels. Add a main title
in a bold font .

1 . Select "Annotate' from the Graph main menu .

2. Select "font" from the Annotate menu .

3. Select "boldface" from the font type menu .

4. Select "title" from the Annotate menu .

5. Select "main" from the title type menu .

6. Type Northern Pulp Ltd .

Step 8 : Once a font is selected, it is used for all of the
labels until another font is selected . Add a subtitle to
the graph using the bold font .

1. Select "title" from the Annotate menu .

2 . Select "subtitle" from the title type menu .

3. Type 1977 to 1984

Step 9: To change a font style, select a new font . Add a
bottom title with the roman font .

1. Select "font" from the Annotate menu .

2 . Select "roman" from the font type menu .

3. Select "title" from the Annotate menu .

4. Select "bottom" from the title type menu .

5. Type Preferred Stock Holdings

Step 10 : One more label and the graph will be finished .
Add a side label using the script font :

1 . Select "title" from the Annotate menu .

2 . Select "side" from the title type menu .

3. Type Dollars
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Figure 8-18. Changing the Y axis label format (6), and adding
titles (7-10) completes the graph .

The graph is finished .

The graphs you draw may require options or labeling
selections other than the ones used here . For additional
information, see Chapter 5, "Enhancing Your Graphs :"
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Messages 9-1

(101) Select a series before selecting plot
You selected "plot" before you selected a series .
Select "data ;" "series;" one or more series names,
and then select the "plot" command .

(102) Range of selected series exceeds 1000
The union of the series you selected contains more
than 1000 data points. You can :
•

	

Select the series again, leaving out some that
expand the range .

•

	

Edit the series and remove some of the data
points at the high or low extreme .

(103) Two series, minimum, are required for a
hi-lo-cl graph
You only selected a single series for a hi-lo-cl
graph . You must select either two or three series .
The first two series identify the high and low

'points for each time period . The third series, if
selected, identifies the
close points .

(104) Two series are required for an X-Y graph
You only selected a single series for an X-Y graph .
You must select two series . The first series is
plotted on the X axis and the second on the
Y axis .

(105) There are no common data points in the
selected series
You selected an X-Y or hi-lo-cl graph type and files
that have no common data points . Select files with
common years and periods for these graph types .

(106) The maximum number of series, 12, are
already displayed
The program can display a maximum of 12 series .
You tried to overlay a number of series that
exceeded that total . Select fewer series and select
the command again .

(107) The maximum number of chart types, two,
are already displayed
The program can display a maximum of two

V GRAPH-
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different graph types at a time . You tried to
overlay a graph that already contained two graph
types. As long as you have not exceeded the
maximum number of series, you can overlay using
one of the graph types already in use
in the graph .

(108) Cannot overlay an x-y graph with any other
graph type
You tried to overlay an X-Y graph with another
graph type. You can only overlay an X-Y graph
with another X-Y graph. Erase the currently
displayed graph and then plot it .

(109) Cannot overlay a pie graph
You tried to overlay a pie graph . You cannot
overlay a pie graph with any other type of graph,
including another pie graph . Erase the currently
displayed graph and then plot it .

(110) There is no axis to rescale
You selected "rescale" when there was no graph
displayed or when a pie graph was displayed . You
must have a line, bar, area, X-Y, or hi-lo-cl graph
displayed to use the "rescale" command .

(111) A previously selected series is no longer
in memory
You attempted to plot a series that you have
removed from the working folder since you
selected it. You must select series again via the
"data/series" commands before you can plot . If
you wish to plot the series you removed, select
"file" and load that series back into the
working folder.

(112) There is no text to move
You selected "move" when there is no text or titles
on the displayed graph . You cannot move the axis
labels or the legend with these commands .

(113) No more text can be added to the graph-the text
buffer is full
You have reached the maximum amount of text
that can be added to the graph . You must remove
some text before you can add more .
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(115) The periodicities do not match-select series with
like periodicities
You selected series that have different
periodicities. All selected series must have the
same periodicity. Select again .

(125) Three series, maximum, are allowed for a
hi-lo-cl graph
You selected more than three series for a hi-lo-cl
graph . Only three are allowed . The first two are
used for the high and low points . The optional
third series, if selected, is used for the close
points. Select two or three series and proceed .

(126) Two series, maximum, are allowed for an
x-y graph
You selected more than two series for an X-Y
graph . Only two are allowed . The first is plotted
on the X axis and the second on the Y axis . Select
two series and proceed .

(127) Pie graph data must be all positive or negative,
not mixed
You selected series with mixed positive and
negative data points for a pie graph . Either select
different series or change the points to all positive
or negative.

(128) Selected series exceed maximum of 12

The series to be added would exceed the
maximum of 12 . You either selected too many
series via the Edit "series" command or the
Visi On "TRANSFER" command . You must delete
series so the total will not exceed 12 before
proceeding .

(129) Working folder is full, cannot save the graph
The working folder contains the maximum it can
hold . You must remove some graphs or series
from the working folder. Be sure to save any
important ones in a permanent folder before
removing them .

(133) Cannot add data point-year too large
You cannot add a data point to this series . The last
year is 9999, the largest allowable year. You can
only add a data point if you use the "parameters"
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command to change the starting date to a smaller
number.

(134) Cannot add data point-maximum reached
You cannot add a data point because the series
contains 1000 data points, the maximum number.

(135) No series to select
There are no series in the working folder . Select
"file" in the graph menu and get series or select
"Edit" to create series .

(136) No data points in the area to be deleted
You selected an area that has no data points in it .
Select "continue," the "delete" command, and
then an area that has data points in it .

(137) Edit capacity reached-cannot add all series
You selected an additional series to be edited that
will exceed the 2000 data point limit of the editing
table. Use the "clear" command to remove series
to make room for the additional series .

(139) That name already exists in the working folder
The name you entered for the new series already
exists in the working folder. Series names must be
unique within a folder. Enter a new name .

(140) Edit capacity reached-cannot add data point
The data point you tried to add will exceed the
2000 data point limit of the editing table . Use the
"clear" command to remove series to make room
for the additional series .

(141) Working folder is full-too many series
The working folder already contains 24 series . You
must remove series from the working folder before
you can add more .

(142) Working folder is full-too many graphs
The working folder already contains eight frozen
graphs. You must remove a frozen graph from the
working folder before you can add another .

(144) That folder name already exists
You entered a name for a newly created folder that
already exists in the current folder . Enter a
different folder name .
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(145) Cannot delete a folder until it is empty
You attempted to remove a folder that still contains
information. It may contain types of files other
than series or graphs .

(146) Must create a partition first
The print sheet is not divided into partitions . You
cannot execute that command unless the print
sheet is divided . Select the type of partitioning
from the options sheet.

(223) Rescale is not applicable to pie charts
You selected the "rescale" command when a pie
chart was displayed . This command is not
applicable to a pie chart .

(224) Cannot display another graph with two hi-lo-cl
graphs displayed
You selected "plot" when two hi-lo-cl graphs are
displayed . You must erase the current display
before you plot another graph .

(225) Only zero values can be interpolated
You selected a non-zero value to be interpolated .
You must select a zero value . The zero data point
you select and all adjacent zero data points will be
interpolated between the value of the preceding
non-zero data point and next non-zero data point .
Select "continue" and then a zero data point .

(226) All displayed series are empty-cannot perform
that command
All the series in the edit table are empty. The
command you selected cannot be performed on an
empty series .

(227) That series name already exists in the edit table
You selected "parameters" or "series/new series"
and entered a series name that already exists in
the edit table . All series names in the edit table
must be unique. Enter a unique name .

(228) That series exists in the edit table under a
different name
That series already exists in the edit table with a
different name . You changed the series name with
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the "parameters" command . If you want a copy of
that series, use the "TRANSFER" command .

(229) That value is invalid for this option
You typed in an options sheet value that is too
large, too small, or contains unacceptable
characters. The option is not changed . Select the
option again and enter a correct value .

(230) That file name already exists in the
transmittal folder
You entered a name for a remote print file that
already exists in the transmittal folder. Enter a
different name .

(231) There are no printer models defined
You attempted to print a series or graph on a
remote printer. No remote printers are defined to
the system . You must define the target printer
from the Services window "Printing" menu .

(232) Insufficient memory available to complete
the transfer
You started a "TRANSFER" command but there is
not enough memory available to complete the
command . "quit" all windows that you do not
need for this transfer .

(233) Transfer cancelled-invalid data
You either attempted to transfer data that cannot
be transferred or attempted to transfer data that is
incompatible with the target area . For example,
you may have tried to transfer a single data point
into a graph display, which does not make sense .

(234) There is no text to replace
You selected "replace" when there is no text or
titles on the displayed graph . You cannot replace
the axis labels or the legend with these
commands .

(235) There is no text to delete
You selected "delete" when there is no text or titles
on the displayed graph . You cannot delete the axis
labels or the legend with these commands .
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(236) No series displayed-cannot perform that
command
You selected a command that cannot be performed
when no series are displayed . For example, you
cannot "add" a data point until you have selected
an existing series or created new series .

(237) You entered an invalid number
The program expected a numeric value and you
entered an invalid number that probably has a
non-numeric character or incorrect punctuation .
Reenter the number correctly .

(238) You picked an unrecognized area in the window
You selected an area in the Edit display that has
no meaning in the current context . For example,
you may have tried to add a value to an area that
does not contain a series .

(239) Stacked bar graph exceeds the maximum value
The series you have selected creates a bar graph
bar that exceeds the maximum value the program
can display. You will have to use fewer series
(erase the graph and start over) or display the
information with a different kind of graph .

(240) Error reading or writing to a disk
There was an error reading or writing to a disk .
Check the drive and the disk and then retry the
operation. Make sure the disk is formatted . If the
error persists, you may have a defective disk or
malfunctioning hardware .

(241) The volume is off-line
The volume that you tried to read or write is not
available to the computer at this time. Make sure
the correct disk is in the drive . You might have
forgotten to mount the volume when you put it in
the drive.

(242) The source or destination is not available
A file you need may not be mounted or may be in
use by another program .

(243) The file or folder is in use
You may have another process that is using the file
you need . Check other programs and utilities .
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(244) There is a nonexistent folder or file in the
pathname
You probably attempted to get a file by name .
Most probably you misspelled the name of a
folder in the pathname . Select the command again
and reenter the pathname . It is also possible that
you deleted that folder from the Archives since
you loaded the Visi On Graph program .

(245) There is an invalid / in that name
The name you entered has an invalid slash (/) in
it . Names can contain any characters except the
slash, which is used to separate the folder and
filenames in a pathname .

(246) The folder name is too long-12 characters max
You entered a folder name that exceeds the
maximum length of 12 characters . Reenter a name
of 12 characters or less .

(247) The pathname is too long-64 characters max
You entered a name that causes a pathname to
exceed the maximum of 64 characters . The
combined names that make up a pathname cannot
exceed 64 characters . Reenter a shorter name .

(249) That name already exists
The name you entered already exists in the folder .
It may be the name of a different type of file . Use
the Archives utility to see a list of all the files in
the folder. Enter a different name .

(264) That file is the wrong type for this program
You entered the name of a file that is not a series
or a graph . That file cannot be loaded . You may
have referenced the wrong folder or misspelled a
name. Enter the correct name of a series or a
graph file .
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Overview of the Convert to Graph TM Program

Creating a Folder

Overview of the Convert to Graph' Program A-1

Because the Visi On Graph' program differs in many
respects from the VisiTrend/Plot® program, series
created in the VisiTrend/Plot program must be
converted for use with the Visi On Graph program .

This appendix explains how to use the Visi On Graph
program's simple Convert to Graph' program to
convert your existing VisiTrend/Plot series to series
usable with the Visi On Graph program .

Note: If your VisiTrend/Plot file contains several series
saved under one name, please read "Multiple Series
Files" at the end of this appendix .

When you select "Visi On Convert to Graph" from the
Services window, the copyright display appears . You
must select "continue" from the bottom of the display
to get into the Convert to Graph program .

After you select "continue," a display closely resembling
the Files display appears in the window . The top part of
this display lists all the existing folders in your Archives
central folder. The middle part lists all series in your
Archives central folder .

The menu lists three commands :

Command

	

What It Does

convert

	

Converts VisiTrend/Plot series to Visi
On Graph series .

new-folder

	

Creates a new folder.

quit

	

Removes this program window.

If you want the series you are converting to be placed in
its own folder in your Archives (file system), follow
these steps :
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To create a folder 1. Select "new-folder" from the Convert to Graph
program menu.
You are prompted to enter the new folder name .

Converting Series

2. Type the name of the folder you want .
The folder name must be new ; it cannot be the same
as one of the folders listed in the top part of the
display.

Creating a new folder automatically makes that new
folder the current folder. Consequently, if you convert a
series after creating a folder, it will be placed in the
newly created folder. You need only type the series
name when prompted for the file name of the
converted series; you do not have to type the folder
name as well .

To convert a

	

1. Select the folder where you want the converted
VisiTrend/Plot

	

series to be stored .
series 2. Select "convert" from the Convert to Graph program

menu .
You are prompted to type the name of the
VisiTrend/Plot file to be converted .

3. Type the file name, including the drive, followed by

( ENTER) For example, if you have a VisiTrend/Plot series
named SALES on a floppy diskette in drive A, type
A:SALES.SER. (Remember that the VisiTrend/Plot
program automatically adds a ".SER" extender to its
file names .)

4. You are prompted to type a new series name or
select from the middle part of the display.
If there are already series in the current folder, you
are asked to select one of them to overwrite with the
new series, or select "create' from the menu line to
make a new series .
If there are no series in the current folder, the
program will assume that your are creating new
series in the current folder and ask you for a name .



Multiple Series Files

5. If you select "create" or have no series in the
working folder :
- To give the series a new name, type the name-

up to 12 characters-followed by (ENTER).

You may accept the VisiTrend/Plot series name by
typing (ENTER) without a new file name . If the
VisiTrend/Plot series name was over 12 characters in
length, the new name will be truncated to the first 12
characters .

If you want to place the converted series into a folder
other than the current folder, type the complete folder
name, using slashes as necessary, and then the series
name.

Overview of the Convert to Graph'" Program A-3

6. If you want to replace a series in the current folder
with the new series :
[Ii Select the existing series from the middle part of

the display.

The converted series will be placed in the current
folder.

The VisiTrend/Plot program can save several series in
one file. If your source file contains several series, the
program will ask you for a name for each of the
individual series. The method for naming these series
is the same that described for single-series files . All of
these series must be put in the same folder.
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A
"add" The Visi On GraphTM command in the Annotate
menu that lets you add text to your graph in any
position, either horizontally or vertically . In the Edit
menu, this command lets you insert or add values to
your series .

"add" The Visi On Graph command in the Edit menu
that lets you insert data values in series . In the
Annotate menu, this command lets you add text to
your graphs .

"Annotate" The Visi On Graph command in the
Graph main menu that lets you add text and titles to
your graphs .

Annotate options sheet The Visi On Graph options
sheet that lets you add grid lines, shading, and
legends; change backgrounds; and change tick marks
on the X and Y axes . This options sheet is displayed if
you select "OPTIONS" while you are in the
Annotate menu .

arithmetic fill Adding new values to a series,
increasing each by a fixed amount .

B
bottom title The horizontal label at the bottom
of a graph .

C

Glossary G-1

"clear" The Visi On Graph command in the Edit
menu that lets you erase the series from the window .

"copy" The Visi On Graph command in the Print
menu that lets you duplicate a graph on the partitioned
sheet to be printed .

D
daily periodicity Usually 1 . Also see Periodicity.
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"data" The Visi On Graph command in the Graph
main menu that lets you select series or graphs
for plotting .

"delete" The Visi On Graph command in the Edit
menu that lets you delete data values from series . In the
Annotate menu, this command lets you erase text
or titles .

"Edit" The Visi On Graph command that opens the
Edit menu, where you can select series for editing;
change, add, or delete data values; generate new
values; and change series names, periodicities and start
dates, for example.

Edit display The Visi On Graph program display
where you enter and work with series values . The Edit
display appears whenever you are in the Edit menu .

Edit options sheet The Visi On Graph options sheet
that lets you change data display formats . You can
choose the number of copies you need, or set paper
sizes . This options sheet is displayed if you select
"OPTIONS" while you are in the Edit menu .

Edit table The entire contents of the current series you
are working with in the Edit display. Because the size of
your window may vary, the Edit display itself may not
show all series values .

Editing cursor The highlighted rectangle in the Edit
display that indicates your position in a series .

"erase" The Visi On Graph command in the Print
menu that lets you erase a graph from the sheet to be
printed. In the Graph main menu, this command
erases the displayed window .

factor The number that is multiplied against or added
to your beginning value when you are generating
values to fill a series . Also see Seed value; Geometric
fill; Arithmetic fill .

"file" The Visi On Graph command in the Graph
main menu that lets you file (save) and retrieve (load)
series and graphs .

E
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fill To generate new values for an existing series .

"fill" The Visi On Graph command in the Edit menu
that lets you generate new data values in a series . Also
see Arithmetic fill ; Geometric fill .

"font" The Visi On Graph command in the Annotate
menu that lets you change the text and title typeface .

"freeze" To save the graph's series, options,
annotation, and scale . Freezing a graph allows you to
retrieve it later.

geometric fill Adding new values to a series,
increasing each geometrically (multiplying by a factor) .

"goto" The Visi On Graph command in the Edit menu
that lets you move directly to a specific date in
your series .

"Graph display" The Visi On Graph display that lets
you draw and change options on your graphs .

"hardcopy" The Visi On Graph command in the Edit
menu that lets you print series data values. In the Print
menu, this command lets you print your graphs .

interpolation Replacing a range of zero values with
new entries that are evenly incremented within
the range .

Label Any title, text, or legend used on a graph .

Legend A special group of labels used to identify the
series that are used in a graph .

Main title The horizontal label at the top of a graph .

Major label A label that you select to appear at the
tick marks of your major period . Also see Major period .
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Major period In series with periodicities other than
one (1), the primary time cycle that is plotted
in a graph .

Minor label A label that you select to appear at the
tick marks of your minor period . Also see
Minor period .

Minor period In series with periodicities other than
one (1), a secondary time cycle that is plotted
in a graph .

Monthly periodicity 12 . Also see Periodicity.

"move" The Visi On Graph command in the Annotate
menu that lets you move text and titles on your graphs .
In the Print menu, this command lets you move a
graph from its current location on the sheet to
be printed .

P
"parameters" The Visi On Graph command in the
Edit menu that lets you change series periodicity,
names, and start dates.

Partitioning Printing two or four graphs per
printed page .

periodicity The number of times a series is reported
before the time cycle begins again .

"plot" The Visi On Graph command in the Graph
main menu that lets you draw your graphs .

precision The number of decimal places to which
numbers are displayed .

"Print" The Visi On Graph command in the Graph
main menu that lets you use the commands related to
printing your graphs .

Print display The display where you preview your
graphs before printing them .

Print options sheet The Visi On Graph options sheet
that lets you partition your graphs ; choose the number
of copies you need; set paper sizes ; and choose a
printer. Also see Partitioning .

"put" The Visi On Graph command in the Print menu
that lets you place a graph on the sheet to be printed .
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quarterly periodicity Four (4) . Also see Periodicity.

"quit" The Visi On Graph command in the Graph
main menu that lets you leave the program .

R
"replace" The Visi On Graph command in the Edit
menu that lets you change data values in series . In the
Annotate menu, this command lets you replace existing
text or titles .

"rescale" The Visi On Graph command in the Graph
main menu that lets you change X- and Y-axis scales .

S

Glossary G-5

seed value The number your new values will begin
with when you are generating values to fill a series .
Also see "fill ."'

series Numbers representing things or events that
are based on a common source, usually in
chronological order.

"series" The Visi On Graph command in the Edit
menu that lets you select series for editing .

Side title The vertical label parallel to the Y axis on a
graph (maximum 24 characters) .

Start date The first reported date in a graph ; usually a
year, such as 1983 .

Start period The first reported period in a graph . In
graphs with a periodicity of 1, start dates and start
periods are identical .

"Style" The Visi On Graph command in the Graph
main menu that lets you select a type of graph-line,
bar, X-Y, pie, or high-low-close .

Subtitle The horizontal label at the top of a graph,
under the main title . It is smaller than a main title
when printed .

"swap" The Visi On Graph command in the Print
menu that lets you exchange the location of two graphs
on the sheet to be printed .
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T

Text page In the Visi On Graph program, a special
display or partition of text that you can create with the
program's font capabilities .

Tick mark labels The numbers along the X and Y axes
that show the value or period of the plotted points .

Title A word or group of words on a graph . Always
found in a fixed position, they are used to identify the
contents of the graph . Also see Main title ; Subtitle;
Bottom title; Side title .

"title" The Visi On Graph command in the Annotate
menu that lets you add titles to your graphs . In the
Print menu, this command lets you add titles to the
sheet to be printed .

U

"undo" The Visi On Graph command in the Edit
menu that lets you remove the changes you made in
your current editing session .

Weekly periodicity Usually 4, 13, or 52 . Also see
Periodicity.

X-Y graph A plot of the intersections of the points of
two series .



Function Index





Function Index

C
Creating series, 3-5 to 3-8

Adding numbers, 3-7 to 3-10
Removing numbers, 3-10 to 3-12
Inserting numbers, 3-14 to 3-15
Moving around, 3-16

Changing dates, names, periodicities, 3-16 to 3-18
Clearing series, 3-27 to 3-28

Creating graphs, 41
Plotting, 4-2 to 4-7
Adding or removing grid, 5-17 to 5-19
Adding labels, 5-1 to 5-5
Adding legend, 5-10 to 5-12
Adding text, 5-4 to 5-5
Adding titles, 5-3 to 5-4, 6-13 to 6-14
Changing axes labels, 5-12 to 5-15
Changing background color, 5-17
Changing scale, 5-21 to 5-25
Changing shading, 5-15
Moving labels, 5-7 to 5-8
Replacing labels, 5-5 to 5-6
Removing labels, 5-9

E

Erasing graphs, 4-23 to 4-24

G

Getting series and graphs, 2-11 to 2-13

0

Organizing series and graphs, 2-13 to 2-17
Creating folders, 2-14 to 2-16

Function Index FI-1
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Moving graphs to another folder, 2-16 to 2-17
Moving series to another folder, 2-16 to 2-17
Removing folders, 2-17
Removing series and graphs, 2-17 to 2-18

Printing, 6-1
Graphs, 6-3 to 6-5
Copying graph, 6-11
Changing print options, 6-14 to 6-16
Moving graph to another partition, 6-9
Series, 61 to 6-3

Q

Quitting the program, 1-11

Saving series and graphs, 2-1 to 2-8

T

Transferring information into programs, 7-2 to 7-5
Selecting area for incoming graphs, 7-2 to 7-3
Selecting area for incoming numeric information, 7-3

to 7-5
Transferring information out of program, 7-5 to 7-6

Selecting graphs for transfer, 7-6 to 7-7
Selecting series for transfer, 7-7 to 7-12
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Background color, 5-1, 5-17
Bar graph, 1-1, 4-3, 9-2

axes, 5-21
comparative, 41, 4-8, 4-12 to

4-13, 81, 8-9 to 8-10
exercises, 8-1, 8-9 to 8-10
more than one series, 4-7
plotting, 4-2 to 4-13, 8-8 to 8-10
shading, 51, 5-15
side-by-side. See Bar graphs,

comparative
single-series, 4-3

Index I-1

"data;' 1-2, 1-5
"delete"

in series, 3-10 to 3-12
labels, 5-9

"done;' 2-5
"Edit," 1-3, 1-5, 3-5
"erase," 1-3, 4-23 to 4-24,

5-2,6-12
"file," 1-3, 1-5, 2-1, 2-5
"get-by-name," 2-4, 2-11
"goto," 3-16
"hardcopy," 6-1, 6-4
"move,' 5-7 to 5-8, 6-9, 9-2

A stacked, 4-1, 4-7 to 4-8, 4-10
to 4-11, 8-1, 8-10 to 8-11

"add" command
labels, 5-4 to 5-5

overlaying
comparatives, 5-21

numbers, 3-7 to 3-10 B K

	

key, 2-7
Adding

graphs to a print display, 6-8
grid, 5-17 to 5-19

Boldface font, 5-1, 5-12

C
labels, 5-1 to 5-5
legend, 5-10 to 5-12
numbers to series, 3-7 to 3-10

arithmetically, 3-18 to 3-19,

Changing
axes labels, 5-12 to 5-15
background color, 5-1, 5-17

3-22 to 3-24 graph options, 8-22 to 8-24
geometrically, 3-18 to 3-19,

3-20 to 3-22
layout, 6-15
number of copies, 6-14

interpolating, 3-18 to 3-19,
3-19 to 3-20

number display, 3-24 to 3-26
print options, 6-14 to 6-16

text, 5-4 to 5-5 scale, 5-1, 5-21 to 5-25
title, 5-3 to 5-4, 6-13 to 6-14 series names, 3-16 to 3-18

"Annotate" command, 1-3
Archives, 2-1 to 2-5

utility, 2-17
Area graph, 1-1, 4-3 to 4-4, 9-2

axes, 5-21
plotting, 4-2 to 4-7
shading, 5-1, 5-15

Arithmetic fill, 3-18 to 3-19, 3-22
to 3-24

series periodicities, 3-16 to 3-18
series dates, 3-16 to 3-18

"clear" command, 3-27 to 3-28
Clearing series, 3-27 to 3-28
Color background, 5-1, 5-17
Command(s)
"add;' 5-4 to 5-5
"Annotate,' 1-3
basic, 1-1, 1-2 to 1-3

Axes, 3-2, 5-12 to 5-15, 5-21 to 5-25, "choosing," 1-2
9-2 "clear," 3-27 to 3-28

B
"copy," 6-11
"create-folder," 2-5, 2-9
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"new series;' 3-5 to 3-6
"parameters," 3-17, 7-5, 9-2 to 9-3
"plot;' 1-3, 1-5, 5-2, 91
"Print," 1-3, 1-5
"quit," 1-3, 1-5, 1-6, 2-10 to 2-11

"delete" command
labels 5-9
numbers, 3-10 to 3-12

Display
files, 2-1 to 2-5
graph, 4-23 to 4-24
options, 1-1

Dollar format
in Edit display 3-24 to 3-26
in Graph display 5-13, 8-22

"done" command, 2-5

E

"remove;' 2-4, 9-2
"replace"
labels, 5-5 to 5-6
numbers, 3-12 to 3-14

"rescale," 1-3, 5-2, 5-21 to 5-25,
9-2,9-5

"start-over,' 3-9
structure 1-5
"style," 1-3
"swap;' 6-10
"title," 5-3, 6-13
"TRANSFER," 1-2, 3-4, 4-1, 7-1

to 7-18
"undo;' 3-26 to 3-27

"copy" command, 6-11

"Edit"
capacity, 9-3, 9-4
command, 1-3, 3-4
display, 3-5, 3-27 to 3-28

Editor, 1-1
(E N D) key, 2-7Copying

graph, 6-11

"'create-folder" information, 7-1command, 2-6, 2-14
to 2-16

Creating
graphs, 4-1 to 4-2

exercises, 8-1, 8-5 to
8-14, 8-18 to 8-25

labels, 1-1, 5-1, 8-18, 8-24 to 8-25

"erase" command
in Annotate display, 5-2
in Graph display, 1-3, 4-23

4-24
in Print display, 6-8, 6-12

Erasing graph
in Graph display 4-23 to 4-24
in Print display 6-8, 6-12

Error. See Mistakes
series, 3-5 to 3-8

exercises, 8-1, 8-2 to 8-5 F
new, 3-5 to 3-8

text pages, 8-1, 8-16 to 8-17
Cumulative information, 4-3, 4-8,

4-10 to 4-11

Factor, 3-20 to 3-22
File(s)

command, 1-3, 2-1, 2-4
Current folder, 2-3 display, 2-1 to 2-5

names, 2-5, 2-11 to 2-13, 9-5
D organizing, 2-1, 2-13 to 2-18

Data
command, 1-3, 1-5, 2-6

replacing, 2-8
Filing system, 2-1, 2-14
"fill;" 3-18 to 3-19

points, 9-1, 9-3, 9-4, 9-5 arithmetic, 3-18 to 3-19, 3-22
Dates to 3-24

changing, 3-16 to 3-18
start, 3-2, 3-7, 3-16

geometric, 3-18 to 3-19, 3-20
to 3-22

Decimals, 3-24, 5-12 to 5-14 interpolation, 3-18 to 3-19, 3-19
D E L key, 2-7 to 3-20



Fixed point
in Edit display, 3-24 to 3-26
in Graph display, 5-13 to 5-14

Floating point
in Edit display, 3-24 to 3-26
in Graph display, 5-13 to 5-14

Folder, 2-2 to 2-3, 2-12 to 2-17, 9-3,
9-4

looking through, 2-12
name, 9-4
removing, 2-17
transmittal, 6-1
working, 2-2, 2-5, 9-3, 9-4

"font," 5-1, 5-8 to 5-9, 8-24
Framing, 1-1, 8-22

G

Geometric fill, 3-20, 3-23 to 3-24
"get-by-name"
command, 2-4, 2-13

Getting series and graphs, 2-11
to 2-13

"goto" command, 3-16
Graph(s)

adding grid to, 5-17 to 5-19
adding to printed page, 6-8
area . See Area graph
bar. See Bar graph
changing scale, 5-21 to 5-25
command, 1-5
copying, 6-11
creating, 4-1 to 4-2, 8-1
display, 4-23 to 4-24
erasing, 4-23 to 4-24, 6-12
freezing, 2-6
getting, 2-1 to 2-4, 2-11 to 2-12
high-low . See High-low graph
high-low-close . See

High-low-close graph
incoming, 7-2 to 7-3
labeling, 5-1 to 5-5, 8-24
line . See Line graph
mixed, 8-1, 8-15 to 8-16
moving, 6-9
naming, 2-6 to 2-10

Index 1-3

options, 1-7, 5-9 to 5-19, 8-22
to 8-24

organizing, 2-1 to 2-5, 2-13 to 2-17
overlay, 4-24, 5-1, 5-20 to 5-21
partitioned, 6-5 to 6-7
pie . See Pie graph
plotting, 4-2 to 4-23
printing, 2-6, 6-1, 6-3 to 6-5
redrawing, 4-23 to 4-24
removing, 2-17 to 2-18
revised, 2-8 to 2-9
saving, 1-3, 2-1 to 2-11
selecting for transfer, 7-6 to 7-7
shading, 5-1, 5-15
stored, 2-6 to 2-8
switching positions, 6-10
types of, 4-1
X-Y, See XY graph

Grid, 1-1, 4-16, 5-17 to 5-19, 8-22

H

"Hardcopy" command, 6-1 to 6-3,
6-4 to 6-5

Height . See Scale
"HELP," iii, 1-9
High-low-close graph, 1-1, 4-1, 9-1,

axes, 5-21
exercises, 8-1, 8-13 to 8-14, 8-20
and grids, 4-16, 5-17
plotting, 4-13 to 4-16

HIGH-LOW-CLOSE series, 8-4
to 8-5, 8-13 to 8-14, 8-20

entering, 8-1, 8-4 to 8-5
High-low graph, 4-1, 4-13 to 4-16

I

INCOME series, 8-1, 8-2, 8-5,
8-7, 8-8, 8-9, 8-10, 8-11

entering, 8-2 to 8-3
Inserting numbers, 3-14 to 3-15
Interpolation, 3-20 to 3-21
Inventory, 4-3, 4-8



1 -4 Index

K

Key(s)

L

(BKSP
(DEL)
(END)

Labeling, 51 to 5-5, 6-13 to 6-14,
8-24 Label(s) . See also
Legend; Text; Title

adding, 1-3
axes, 3-1, 5-12 to 5-16, 9-2
command, 6-3, 6-13 to 6-14
creating, 1-1, 5-1, 8-18, 8-24
moving, 1-1, 5-7 to 5-8
and overlay, 5-20
removing, 1-1, 5-9
replacing, 5-5 to 5-6
tick mark, 3-1, 3-2, 512 to 5-15
typefaces, 5-8 to 5-9
vertical, 5-3, 5-4 to 5-5

Layout, 6-15 to 6-16
Legend, 5-2, 5-3, 5-10 to 5-12, 9-2

adding or removing, 5-10 to 5-12
Line graph, 1-1, 4-1, 9-2
axes, 5-22
and grids, 5-21
multiple-series, 8-1, 8-7 to 8-8
overlay, 8-20 to 8-21
plotting, 4-2 to 4-7
single-series, 81, 8-5 to 8-6
use, 4-2

Line option, 4-4 to 4-5, 4-19
Local printing, 6-1

M

Measurements, 3-1, 4-2
Memory, insufficient, 9-6
Menu(s), 1-3, 1-4 to 1-5
commands, 1-4

Messages, 9-1 to 9-8
Mistakes

correcting, 3-26 to 3-27
in selecting series, 3-6

,27
,27
,27

Mixed graph, 8-15 to 8-16
"move" command, 5-7 to 5-8, 6-3,

9-2
Moving

around in a series, 3-16
graphs

to another folder, 2-16 to 2-17
to another partition, 6-9

labels, 1-1, 5-7 to 5-8
series, 2-16 to 2-17

N

Name, 9-4, 9-5
"new series" command, 3-6
Numbers
adding

arithmetically, 3-18 to 3-19,
3-22 to 3-24

geometrically, 3-18 to 3-19,
3-20 to 3-22

to series, 3-7 to 3-10
display, 3-27 to 3-28
inserting, 3-14 to 3-15
interpolating, 3-18 to 3-19, 3-19

to 3-20
removing, 3-10 to 3-12
replacing, 3-12 to 3-14

Numeric information, 1-1
entering, 1-1
incoming, 7-3 to 7-5
selecting for transfer, 7-7 to 7-12

0

"OPTIONS," command, 1-2, 5-9,
6-14

Options
display, 1-1
graph, 1-7, 5-9, 8-22 to 8-24
sheet, 1-2, 1-7, 5-9, 6-14 to 6-16
graph, 5-2, 5-11
print, 5-2, 5-11, 6-6

Organizing series and graphs, 2-1
to 2-5, 2-13 to 2-14

Overlay
exercise, 8-18,8-20
graph, 4-24, 5-1, 5-20 to 5-21, 9-2



P

"parameters"
changing, 3-16 to 3-18 command,

3-16, 7-4 to 7-5, 9-3 to 9-4
Partitioning, 6-5 to 6-7, 9-5
Pause After Page?, 6-15
Percentages, 4-2
Periodicity, 3-1 to 3-4, 9-3

changing, 3-16 to 3-18
Pie graph, 1-1, 4-1, 9-2, 9-3, 9-5

exercise, 8-1, 8-11 to 8-12
overlay, 5-20
plotting, 4-20 to 4-23
shading, 5-1, 5-15

"plot" command, 1-3, 5-2, 9-1
Plotting

graphs, 4-2 to 4-7
bar, 4-2 to 4-7, 4-7 to 4-13
high-low-close, 4-13 to 4-16
pie, 4-20 to 4-23
X-Y, 4-16 to 4-19

Point
fixed

in Edit display, 3-24 to 3-26
in Graph display, 5-13 to 5-14

floating
in Edit display, 3-24 to 3-26
in Graph display, 5-13 to 5-14

Pointer, 1-1, 1-2
Precision, 3-24 to 3-26
"Print"
command, 1-3
local, 6-1
options, 6-5 to 6-7, 6-14 to 6-16
remote, 6-1

Print Document on, 6-15 to 6-16
Printer, 6-1, 6-15 to 6-16, 9-6

selecting, 6-15 to 6-16
Printing, 6-1

graph, 2-6, 6-1, 6-3 to 6-5
series, 6-1 to 6-3

Prompt messages, 2-2

Q
"quit" command, 1-11, 2-10 to 2-11
Quitting the program, 1-3, 2-10

to 2-11

R

Index 1-5

Rainfall, 3-1, 4-17
Record, permanent, 2-1
Redrawing graph, 1-1, 4-23

to 4-24
Redraw mode, 5-10
Remote printing, 6-1
"remove" command, 2-4, 9-2
Removing

folders, 2-17
grid, 5-17 to 5-19
labels, 5-9
legend, 5-10 to 5-12, 8-22
numbers from series, 3-10 to 3-12
series and graphs, 2-17 to 2-18

"replace" command, 3-11, 3-13,
5-8,9-2

Replacing
labels, 5-5 to 5-6
numbers in series, 3-12 to 3-14
titles, 6-14

"rescale" command, 1-3, 5-2, 5-21
to 5-25, 9-2, 9-4

Roman, 5-1, 5-8 to 5-9

S
Sales, 3-1, 4-3, 4-8, 4-17
Saving

series and graphs, 2-1 to 2-8, 2-8
to 2-10, 2-10 to 2-11

new, 2-1 to 2-8
revised, 2-8 to 2-10

when quitting program, 2-10
to 2-11

Scale, 5-1, 5-21 to 5-25
Scores, 31
Selecting

area for incoming graphs, 7-2
to 7-3

area for incoming numeric
Information, 7-3 to 7-5

graphs, 7-6 to 7-7
numeric information, 7-7 to 7-12

Series, 3-1
adding numbers to, 3-7 to 3-10
attaching to chart, 6-3
changing, 3-16 to 3-18, 4-3



1-6 Index

clearing, 3-27 to 3-28
converting, A-1 to A-3
copying, 7-1
creating, 3-5 to 3-8, 7-3 to 7-5

exercises, 8-1, 8-2 to 8-5
getting, 2-1 to 2-5, 2-11 to 2-12
inserting numbers into, 3-14

to 3-15
long, 6-2 to 6-3
moving, 2-14 to 2-15
moving around in, 3-16
names, 2-5 to 2-6, 2-7 to 2-8, 3-16

to 3-18, 7-5 to 7-6, 9-5
organizing, 2-13 to 2-17
periodicity, 3-1 to 3-4
placing in folders, 2-8 to 2-10
printing, 6-1 to 6-3
removing, 2-17 to 2-18
removing numbers from, 3-10

to 3-12
sample
entering, 8-1 to 8-6
exercises using, 8-7 to 8-16,

8-18 to 8-25
replacing numbers in, 3-12

to 3-14
saving, 1-3, 2-1 to 2-10, 2-10

to 2-11
Series and graphs, saved, 2-1
Shading, 1-1, 5-1, 5-15 to 5-16
Special effects, 51
Start date, 3-2
"start-over" command, 3-9
Start value, 3-20 to 3-22, 3-22

to 3-24
Stock price histories, 4-1,

4-14
Storage, permanent, 2-2
"style" command, 1-3
"swap" command, 6-10

T

Temperatures, 4-2
Text, 5-2, 5-4 to 5-5

adding, 5-1, 5-4 to 5-5
buffer, 9-2
pages, 8-1, 8-16 to 8-17

Tick mark, 3-1 to 3-2

add or remove, 5-1, 5-12 to 5-15
labels, 3-1 to 3-2, 5-12 to 5-15

Time periods, 3-2
Title(s), 5-3

adding, 5-3 to 5-4, 6-13 to 6-14
bottom, 5-1, 5-2 to 5-4, 6-13

to 6-14
command, 5-4, 6-13
erasing from print display, 6-12

to 6-13
main, 5-1, 5-2, 5-3, 6-3, 6-13
removing, 5-9
replacing, 5-5 to 5-6, 6-14
side, 5-1, 5-3
sub-, 5-1, 5-2, 5-3, 6-3, 6-14

"TRANSFER" command, 3-5,4-1,
7-1, 7-3 to 7-7

Transferring information
into program, 7-2 to 7-5
out of program, 7-5 to 7-12

Transmittal folder, 6-1
Typefaces . See Font

U

"undo' command, 3-26 to 3-27

V

Values
negative, 4-10
start, 3-20 to 3-22, 3-22 to 3-24
zero, 3-18 to 3-20, 9-5

Visi On Convert to Graph program,
A-1 to A-3

Visi On Graph QuickStart Course,
i, ii, iii, 1-1, 1-9

Visi On Setup Guide, 1-9
Visi On Tutorial, i, ii
Visi On User's Guide, i, ii, 6-1, 7-2
VisiTrend/Plot program, converting,

A-1 to A-3
Volume information, 4-3, 4-7

W

Width . See Scale
Working folder, 2-2, 2-5, 9-3, 9-4



X

X- and Y-axes
labels, 5-12 to 5-15
scale, 5-21 to 5-25

X-Y graph, 1-1, 4-1, 9-1, 9-2, 9-3
axes, 5-21
exercises, 8-1, 8-12 to 8-13
overlay, 5-20 to 5-21
periodicity, 3-4
plotting, 4-16 to 4-19

X-Y series, 8-12
entering, 8-1, 8-3 to 8-4

Y

Y-axis, 8-22 to 8-23

Z

Zero values, 3-18 to 3-20, 9-5

Index I-7





Visi On GraphTM

Reader's Critique

IBM° Personal Computer
69939-2211 12/83

VisiCorp's Publications Department wants to provide documents
that meet the needs of all our product users . Your feedback helps us
produce better manuals .

Please tell us how you rate this manual in the following areas :

Your computer experience : ∎ 2 yrs or less ∎ 2-5 yrs ∎ 5 yrs +
Did you use the manual to learn the program? ∎ Yes ∎ No
I read ∎ 25 % ∎ 50 % ∎ 75 % ∎ 100 % of this manual .

Please specify, by page, any errors you found in this manual .

Please tell us for what application(s) you are using this program .

What one thing could we do to improve this manual for you?

excellent

	

Good

	

Average
(v)

	

(v)

	

(v)
Fair
(v)

Poor
(v)

Completeness of information .
Clarity of information .
Organization of manual .
Appearance of manual .
Quantity of examples .
Usefulness of examples .
Quantity of photographs and
illustrations .
Appropriateness of photographs
and illustrations .
Degree to which this manual meets
your expectations and needs .
Appropriateness of the manual level
to a person of your experience .

rOverall manual .

Name Title
Company
Address
City State Zip
Phone : (Office) (Home)







2895 Zanker Road

	

IBM° Personal Computer
San Jose, CA 95134

	

VISICORP

	

Visi On GraphTM
Phone : 408/946-9000

	

69939-2211 1 .
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